Desarrollo de un programa
didactico de elementos finitos para
problemas elasticos lineales en tres

dimensiones

Alejandro Robayo Zapata

Universidad Nacional de Colombia
Facultad de Ingenieria, Departamento de Ingenieria Civil y Agricola
Bogota, Colombia
2020






Desarrollo de un programa
didactico de elementos finitos para
problemas elasticos lineales en tres

dimensiones

Alejandro Robayo Zapata

Trabajo de grado presentado como requisito parcial para optar al titulo de:
Magister en Ingenieria - Estructuras

Director:
PhD Dorian Luis Linero Segrera

Codirector:
PhD Martin Estrada Mejia

Linea de Investigacion:
Analisis Estructural
Grupo de Investigacion:
GIEs. Analisis, Disefio y Materiales

Universidad Nacional de Colombia
Facultad de Ingenieria, Departamento de ingenieria Civil y Agricola
Bogota, Colombia
2020






Dedico este trabajo a mi hijo Manuel,
por ensenarme tantas cosas.






Mis mas sinceros agradecimientos a las siguientes personas:

Al profesor Dorian Linero, director del trabajo de grado,
por su dedicacién y paciencia para ensenarme los conceptos
y las herramientas que me permitieron realizar este trabajo.

Al profesor Martin Estrada, codirector del trabajo de grado,
por sus valiosos consejos y oportunos aportes.

A mi esposa Mery, mi hija Mariana, mi sobrino Felipe
y a mi mamé por su confianza y apoyo incondicional.






Resumen

Desarrollo de un programa didactico de elementos finitos para
problemas elasticos lineales en tres dimensiones

En el presente trabajo final de maestria se desarrolla y documenta un programa
didéactico de elementos finitos a codigo abierto escrito en pseudo lenguaje matematico,
capaz de simular el proceso de analisis de un problema mecéanico elastico lineal en
tres dimensiones bajo cargas estaticas. Particularmente, se implemento el elemento
finito hexaédrico de ocho nudos y el elemento tipo prisma de 6 nudos.

La finalidad de este trabajo es apoyar el aprendizaje, la investigacién y la pro-
fundizacién en el andlisis estructural de sélidos tridimensionales mediante el método
de los elementos finitos.

El programa desarrollado es una extension del programa de elementos finitos a
cédigo abierto PEFICA 2.0, en el cual se implementaron nuevas rutinas en GNU-
Octave, relacionadas con el proceso de cédlculo y con el pre y postproceso grafico
realizado con GMSH.

Se simularon dos ejemplos de aplicacién utilizando el programa desarrollado, cu-
yos resultados como el desplazamiento maximo y los esfuerzos principales, fueron
similares a los obtenidos con el programa comercial ANSYS. Lo anterior verifica el
correcto funcionamiento del programa desarrollado.

Palabras Clave

Método de elementos finitos, Analisis mecanico estatico elastico tridimensional, Pro-
gramacion didéctica a cédigo abierto, Elemento finito hexaédrico y sus simplificacio-
nes.
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Abstract

Development of a finite element didactic program for linear
elastic problems in three dimensions

In this final master’s work, an open source finite element didactic program written in
pseudo-mathematical language is developed and documented, capable of simulating
the analysis process of a linear mechanical elastic problem in three dimensions under
static loads. In particular, the eight-node hexahedral finite element and the six-node
prism-type element were implemented.

The purpose of this work is to support learning, research and deepening in the
structural analysis of three-dimensional solids through the finite element method.
The developed program is an extension of the open source finite element program
PEFiCA 2.0, in which new routines were implemented in GNU-Octave, related to
the calculation process and the graphic pre- and post-processing made with GMSH.

Two application examples were simulated using the program developed, whose
results, such as maximum displacement and main stresses, were similar to those
obtained with the commercial program ANSYS. This verifies the correct operation
of the developed program.

Keywords

Finite element method, Three-dimensional static-elastic mechanical analysis, Open
source didactic programming, Hexahedral finite element and its simplifications.
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Capitulo 1

Introduccion

Este documento describe el trabajo final de maestria titulado ”Desarrollo de un
programa de elementos finitos para problemas elasticos lineales en tres dimensiones”.
El primer capitulo contiene la introducciéon general y los objetivos propuestos. En
el segundo capitulo se presentan los antecedentes, en donde se explican brevemente
algunos programas didacticos de elementos finitos similares. En el tercer capitulo
se describe el marco tedrico, indicando la formulacién del método de los elementos
finitos para el elemento hexaédrico trilinear y para el elemento tipo prisma.

En el cuarto capitulo se detalla la metodologia con la que se realiza cada una de
las etapas del presente trabajo. En el quinto capitulo se explica la implementacién
del programa. En el capitulo sexto se muestran ejemplos de aplicacion del progra-
ma desarrollado, junto con la comparacion de resultados con el programa comercial
Ansys. En el capitulo séptimo se presentan las conclusiones y recomendaciones para
futuros trabajos. Finalmente el capitulo octavo es el manual de usuario del programa
desarrollado.

El programa desarrollado, los ejemplos de aplicacion y el documento de este
trabajo final de maestria se puede descargar en el siguiente vinculo Trabajo final.

1.1. Motivacion

El método de elementos finitos aplicado al andlisis estructural ha adquirido cada
vez mas importancia, gracias al aumento de la capacidad de procesamiento de los
computadores desde su aparicién en la década de los setentas (Linero, 2010). Por
lo anterior, los programas académicos de Ingenieria Civil y Mecanica de muchas
universidades han incluido el método de los elementos finitos entre sus asignaturas.

Asimismo, algunas instituciones educativas y de investigacion han desarrollado
programas didéacticos de elementos finitos a cédigo abierto, disenados con el objetivo
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de mejorar el aprendizaje del método en los estudiantes y a su vez, servir como herra-
mienta para futuras investigaciones. En la Tabla 1.1 se muestran algunos programas
de este tipo creadas por diferentes universidades e instituciones en varios paises, de
los cuales se indica el ano de su ultima version.

Tabla 1.1: Programas didécticos de elementos finitos

Programa Institucion Ano Lenguaje

788 University of Bayreuth (Alemania) 1985  Fortran y C
FreeFem Universidad Pierre y Marie Curie 1987 C++

(Paris, Francia)
CodeAster Electricité de France (EDF) 2001  Fortran y Python
MatFem CIMNE - Universidad Politécnica de 2006 Matlab

Cataluna (Barcelona, Espana)

Feap University of California (Berkeley, 2020 Fortran
EEUU)

Su2 Stanford University (EEUU) 2012 C++, Python

Calfem Universidad de Lund (Suecia), 2004 Matlab

PEFiICA Universidad Nacional de Colombia 2020  Octave o Matlab
2.0

Existen varios programas comerciales de simulacién numérica de problemas fisi-
cos mediante el método de los elementos finitos como ANSYS, Abaqus y NASTRAN,
entre otros. Por otra parte, la mayoria de los programas comerciales de analisis de es-
tructuras reticulares como SAP2000, ETABS o STAAD, han incluido procedimientos
de simulacién de placas y solidos mediante el método de los elementos finitos.

En este trabajo se produce y documenta un programa didactico a cédigo abierto
para solucionar problemas elasticos lineales en tres dimensiones, utilizando para ello
programacion estructurada y modular, la cual permite una mejor interpretacion del
c6digo dentro de cada médulo (Molina, 2006).

Este programa es una ayuda didéactica para el aprendizaje del método de los
elementos finitos en tres dimensiones y también una herramienta para estudios que
requieran apoyarse con este tipo de analisis.

1.2. Objetivo General

Crear y documentar un programa didactico de elementos finitos a cédigo abierto
escrito en pseudo lenguaje matematico, capaz de simular el proceso de anédlisis de un

© Alejandro Robayo Zapata
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problema mecanico elastico lineal en tres dimensiones bajo cargas estdticas.

1.3. Objetivos Especificos

e Generar los algoritmos de conexién para el programa de preproceso, que permi-
ta vincular los datos de la geometria y enmallado, con el programa de proceso
creado.

e Crear las rutinas de proceso en pseudo lenguaje matematico utilizando progra-
macién estructurada, que permitan calcular el desplazamiento, la deformacién
y el esfuerzo para cada punto dentro del sélido mediante el método de elementos
finitos.

e Generar un archivo de salida, que contenga los resultados obtenidos en un
formato que permita su visualizaciéon en un programa de postprocesamiento.

e Verificar los resultados de algunas simulaciones del programa desarrollado con
un programa comercial de elementos finitos.

e Documentar de forma didactica el programa presentando ejemplos de aplica-
cién.

1.4. Metodologia general

El programa de computador desarrollado en este trabajo final de maestria implemen-
ta su metodologia de analisis en lenguaje interpretado GNU-OCTAVE, una plata-
forma de programacion con base en un lenguaje interpretado de alto nivel, orientado
al cdlculo numérico (Eaton et al., 2017). Las rutinas realizadas en GNU-OCTAVE
seran compatibles con MATLAB.

La estrategia de representacion grafica de los parametros geométricos y fisicos
del problema y de sus resultados, se realizé con el entorno de pre y post proceso del
programa GMSH, el cual esta disponible para varios sistemas operativos y su licencia
es libre y gratuita (Geuzaine & Remacle, 2019).

Las actividades realizadas en este trabajo final de maestria se indican a continua-
cion:

e Inicialmente se definen las rutinas de lectura en GNU-OCTAVE para que la
informacion de la geometria del problema, cargas, condiciones de borde y en-
mallado que se generan desde GMSH pueda ser identificada por las rutinas del
procedimiento principal.

© Alejandro Robayo Zapata
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e En las rutinas de proceso se analiza el problema en tres dimensiones mediante
elementos finitos hexaédricos y su caso especial, el elemento pentaédrico o pris-
ma, de acuerdo al enmallado realizado en GMSH. Con estas rutinas de proceso
se escribe un archivo con los resultados del problema, es decir los desplaza-
mientos, esfuerzos y deformaciones para los nudos y los elementos finitos.

e Para el post proceso se definen las rutinas de escritura en GNU-OCTAVE, de
tal forma que permitan mostrar graficamente sus resultados en GMSH.

e Se realizan simulaciones de cuatro problemas tridimensionales comunes con el
programa propuesto y con el programa comercial ANSYS, con el fin de verificar
sus resultados.

e Se escriben comentarios en las subrutinas de forma amigable y didactica ex-
plicando su funcién y facilitando su uso. Por ejemplo, cada subrutina creada
esta encabezada con comentarios que identifiquen su objetivo y sus argumen-
tos. Ademés el nombre de la subrutina estd asociado a su funcién y tiene un
numero comun de caracteres.

e Se escribe la documentacion del programa, la cual incluye: la descripcién ge-
neral, la estructura y su manejo, los tipos de datos y las matrices utilizadas y
la descripcion de las instrucciones programadas. Asimismo se elabora una guia
con algunos ejemplos de aplicacion.

© Alejandro Robayo Zapata



Capitulo 2

Antecedentes

Para la ensenanza de la ingenieria estructural por el método de los elementos finitos
el uso de programas didacticos es cada vez mas frecuente, debido a que éstos son
difundidos con mayor facilidad (Duque & Mejia, 2007). Varios de los programas
mostrados en la Tabla 1.1 se encuentran ademéas en constante evolucion.

2.1. Estructura basica de los programas de elementos finitos

Los programas de elementos finitos tienen usualmente tres partes fundamentales
denominadas el preproceso, el proceso y el postproceso (Duque & Mejia, 2007; Linero
et al., 2020). A continuacién se describen tales etapas particularmente para la solucién
de problemas mecanicos.

2.1.1. Preproceso

La etapa de preproceso permite al usuario ingresar la informacién del problema de la
mecanica estructural y usualmente estd compuesto por: (i) un entorno de dibujo de
las entidades geométricas como puntos, lineas, superficies y volumenes, (ii) un pro-
cedimiento de asignaciéon de condiciones de borde, acciones aplicadas y propiedades
mecénicas, y (iii) los procedimientos de generacién de la malla de elementos finitos.

2.1.2. Proceso

En la etapa de proceso se transforma toda la informacién ingresada en la etapa previa
a matrices y tablas. A continuacion se realizan las operaciones matriciales definidas
por el método de los elementos finitos, obteniendo como resultados del problema
arreglos que contienen: desplazamientos y fuerzas en los nudos, y deformaciones y
esfuerzos en el interior de los elementos.



6 Desarrollo de un programa didédctico de elementos finitos para problemas eldsticos lineales en tres dimensiones

2.1.3. Postproceso

La etapa de postproceso convierte los arreglos obtenidos en la etapa de proceso, en
distribucion de colores o tonos sobre el solido, curvas de relaciéon y animaciones que
permiten la representacién gréfica de los resultados.

2.2. Programas didacticos y de aprendizaje

Los programas didacticos tienen caracteristicas bien definidas para facilitar su eficacia
en el aprendizaje (Marqués, 1995), como por ejemplo la versatilidad y la posibilidad
de gestionar facilmente la informacién que ellos proporcionan (Marqués, 2002). De
esta manera la implementacién de un programa didactico de elementos finitos de for-
ma estructurada, mediante la creacién de funciones con un objetivo definido, favorece
la caracterizacion de las mismas y se puede identificar mejor el proceso analitico de
cada una.

Ademas, esta programacion estructurada da versatilidad a los procesos vinculados
al calculo principal, con la posibilidad de modificar sus rutinas originales, de permitir
la adicién de nuevos procedimientos y eliminar otros, pensando en futuras mejoras y
cambios en el alcance del programa.

A continuacion se describen brevemente otros programas didacticos desarrollados
para el analisis de estructuras por el método de elementos finitos.

2.2.1. MATFEM

MATFEM es un programa escrito en MATLAB, disenado para introducir a los usua-
rios en el uso practico del método de elementos finitos para solidos y problemas de
campo gobernados por las ecuaciones de Poisson y Laplace en espacios bi- y tri-
dimensionales (mecénica, transferencia de calor, acustica, infiltracién, electromag-
netismo, etc.). Estd vinculado con el programa grafico GID (International Center
for Numerical Methods in Engineering (CIMNE), 1987), para el preproceso y post
proceso de la informacién.

MATFEM contiene algunos archivos en donde se guardan las rutinas completas
para los analisis a partir de los archivos generados desde GID. Es un programa que
aprovecha la capacidad de pre y post procesamiento de GID y numerosas herramien-

tas predefinidas de MATLAB (Link, 2005).
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2.2.2. CALFEM

CALFEM es un programa escrito en MATLAB para ensenar el método de elementos
finitos. El nombre CALFEM es una abreviatura de Computer Aided Learning of
the Finite Element Method. El programa se puede utilizar para diferentes tipos de
problemas de mecanica estructural y problemas de campo.

CALFEM ha sido el resultado de varios desarrollos realizados por la divisién de
mecanica estructural en la Universidad de Lund en Suecia. Contiene una serie de pro-
cedimientos dispuestos en varios archivos de MATLAB, con amplia documentacion.
Su alcance estd limitado a problemas en dos dimensiones (Dahlblom et al., 1986).

2.2.3. PEFiCA

En la Universidad Nacional de Colombia, sede Bogot4 se ha utilizado el programa de
elementos finitos a cddigo abierto PEFIiCA (Linero, 2010) en las asignaturas analisis
matricial avanzado y andlisis estructural por elementos finitos, con el cual los estu-
diantes aplican los conceptos adquiridos en las clases mediante ejemplos de aplicaciéon
con el programa incentivando el aprendizaje de los temas estudiados.

PEFiICA y su posterior actualizaciéon PEFiCA 2.0 (Linero et al., 2020), han fa-
cilitado a los estudiantes la comprensién de la formulacién y la practica del método
de los elementos finitos, brindando una solucién a problemas mecénicos uni-, bi-
y tri-dimensionales con cargas estaticas, deformaciones infinitesimales y de material
elastico lineal isotropico. El codigo de dicho programa coincide con los procedimientos
bésicos implementados en programas comerciales de analisis estructural y elementos
finitos, favoreciendo un mejor desempeno en la practica profesional.

En este trabajo final de maestria se extiende el programa PEFiCA 2.0, al anélisis
de sélidos en tres dimensiones con elementos finitos de orden superior, conservando
las caracteristicas relacionadas con su estructura basica y su objetivo didéactico.
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Marco teorico

La formulacién del método de los elementos finitos para la solucién de un problema
mecanico eldstico lineal tridimensional ha sido descrita en varias referencias (Felip-
pa, 2017a; Linero et al., 2013; Zienkiewicz, 2013). En este capitulo se presenta la
formulacién particular del elemento hexaédrico de ocho nudos y de su simplificacién
al elemento prisma de 6 nudos, los cuales son implementados como parte del presente
trabajo.

3.1. Generalidades del método de los elementos finitos

El método de los elementos finitos permite obtener una solucién numérica aproximada
a problemas del medio continuo, sobre los que se definen ciertas ecuaciones diferen-
ciales o integrales que caracterizan el comportamiento fisico del problema. Particular-
mente en este trabajo se analiza una solucién a problemas mecénicos estructurales
tridimensionales, por lo que las ecuaciones de gobierno vinculan la cinemética, el
modelo constitutivo del material y las condiciones de equilibrio. Asimismo, las can-
tidades de interés son el campo del desplazamiento, de la deformacion y del esfuerzo
en el sélido (Linero et al., 2013).

En el método de elementos finitos, el medio continuo se divide en un nimero finito
de subdominios llamados elementos finitos, los cuales responden a las ecuaciones de
la mecdnica y se encuentran vinculados entre si por nudos (Zienkiewicz, 2013). La
forma de los elementos finitos depende del dominio en el cual se define el problema.
En este caso como el dominio es tridimensional los elementos finitos son también
tridimensionales.
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3.1.1. Funciones de aproximacién y funciones de forma

La variable que se desea obtener a directamente de las ecuaciones de gobierno en
términos de la posicion material en el dominio del problema, se denomina funcion
de aproximacion. Tal funcién es continua en el interior de cada elemento finito, y es
compatible en los nudos de la malla.

Particularmente en problemas mecanicos de sélidos, la funcion de aproximacién
corresponde al campo vectorial del desplazamiento u(z,y, z) y en consecuencia, los
valores de sus componentes en los nudos o también llamados valores nodales son los
grados de libertad del problema.

En el interior de cada elemento finito e, se define una funcién de aproximacion
escalar por cada componente del vector del desplazamiento en las direcciones x, y y
z, de la forma:

u(e)(:r;,y, z) = Nl(e(:c,y, z)uge) +. 4 Nr(f)(x,y, z)u,(f) (3.1a)
v(e)(:c, y,2) = Nl(e) (2,9, z)vge) NI fo(:c, v, z)vr(f) (3.1b)
w'® (x,y,2) = Nl(e) (x,y, z)wge) 4+ N,(f(:z:, Y, z)wne) (3.1¢)

En las expresiones anteriores, v, v y w®

de desplazamiento en el nudo ¢ del elemento e.

Las funciones de forma Ni(e) en el nudo ¢ de un elemento finito e, son polinomios
en términos de la posicién (z,y, z), que determinan el orden de la aproximacién y
que permiten interpolar una componente de desplazamiento a partir de sus valores
en los nudos.

, son los valores de las componentes

3.1.2. Principio del Trabajo Virtual

Se considera un sélido cuyo volumen es V', el cual esta sometido a acciones externas y
tiene restricciones debidas a sus apoyos. Este sélido esta representado mediante una
malla de elementos finitos tridimensionales. En los vértices o nudos de cada elemento
finito se definen las componentes de desplazamiento, las cuales corresponden a los
grados de libertad.

Las fuerzas reales producen un trabajo virtual el cual se divide en dos partes:
el trabajo virtual interno el cual lo realizan las fuerzas internas y el trabajo virtual
externo, realizado por las fuerzas externas.

Las fuerzas a las que el sélido compuesto por ne elementos finitos de volumen V,
esta sometido son:

e fuerzas por unidad de volumen en cada elemento b,

© Alejandro Robayo Zapata
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e fuerzas por unidad de drea p.en el contorno I'; C I}y

e fuerzas puntuales f(zn) aplicadas sobre 7 nudos.

Las condiciones de frontera son los valores conocidos del desplazamiento real

u(x) = [u v w]T = u* en los puntos que hacen parte de un contorno definido I,
(Linero et al., 2020).
El campo del desplazamiento virtual du(x) = [du dv dw]?, corresponde a una

funcién que cumple con la condicién de borde de la forma:

du(x) =0 Vxel, (3.2)

El trabajo virtual externo en cada elemento e se realiza por las fuerzas reales
externas b(e), p(e) y f(x,) mientras se presenta un desplazamiento virtual du(e).

Por otro lado, el trabajo virtual interno es producido por el esfuerzo o, mientras
ocurren deformaciones generadas por desplazamientos virtuales 65ue, por lo tanto
es igual a la densidad de energia de deformacion (65ue)T0'e integrada en el volumen
del elemento finito.

De esta manera, se dice que un cuerpo esta en equilibrio si el trabajo virtual
realizado por las acciones externas e internas es nulo, por lo tanto:

3 / (Voue)To. dV =3 / sulp,dS + / sulb.dV) + 3 du(xa) " (xa)
e=1 V(e e=1 F; ¢

n=1
(3.3)
Los vectores de fuerzas de superficie pe, fuerzas de cuerpo b en los elementos y
fuerzas puntuales en los nudos f(xy,), son de la forma:

Pe =[5 15 0" be=[05 00 0T f(xn) = [fa fy ST (3.4)

3.2. Formulacion del método de los elementos finitos para
problemas de la mecanica estructural lineales tridimen-
sionales

A continuacién se describe brevemente la formulacion del método de los elementos
finitos aplicada a problemas mecéanicos de sélidos elasticos lineales sometidos a cargas
estdticas en el espacio tridimensional (Linero et al., 2020). Tal formulacién es comun
para cualquier tipo de elemento finito en tres dimensiones como los indicados en las
secciones anteriores.
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3.2.1. Matriz de rigidez y vector de fuerzas equivalentes en el sélido

La matriz de rigidez del sélido K se obtiene al ensamblar las matrices de rigidez K©
de los ne elementos que conforman la malla. Esto equivale a la adiciéon de acuerdo
a los grados de libertad asociados al elemento (e), de cada término de la matriz
de rigidez del elemento en la matriz de rigidez del solido. Este procedimiento de
ensamblaje se representa como:

K= A K] (3.5)

El vector de fuerzas nodales totales en la malla f, resulta de la suma del vector
de fuerzas aplicadas directamente a los nudos £™ con el vector f, es decir:

f=f"4f (3.6)

El vector f resulta del proceso de ensamblaje de los vectores f'(e) de cada elemento
vistos en la Ecuacion 3.57, de acuerdo a los grados de libertad asociados a cada ele-
mento, de forma similar a la matriz de rigidez del solido. Este proceso de ensamblaje
de los vectores se representa asi:

i= A [f@] (3.7)
e=1
Por consiguiente, a partir de la Ecuacion 3.51, con la matriz de rigidez del sélido
K, el vector de fuerzas nodales equivalentes en la malla f, el vector de desplazamientos
nodales virtuales da y el vector de desplazamientos nodales reales a se deduce que:

da’Ka—da’f=0 (3.8a)
da’(Ka—f)=0 (3.8b)
Ka=f (3.8¢)

3.2.2. Metodologia para el calculo del vector de desplazamientos nodales
en el sélido

El vector de desplazamientos nodales del sélido a estd compuesto por los desplaza-
mientos desconocidos a, y los conocidos ag, asi:

a=[al a7]" (3.9)
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estos desplazamientos conocidos son los valores nodales de desplazamiento impuestos
en la malla a*. De esta manera la Ecuacion 3.8 se puede representar como:

Koo | Kos| [2a f, 0
—|..l=] .. (3.10)

Ko | Kgs L2 fs 0

De acuerdo con el nimero de desplazamientos nodales conocidos a, y desconoci-
dos ag, la matriz de rigidez K se particiona en cuatro submatrices Kqq, Ko, Kgo ¥
K s. Asimismo el vector de fuerzas nodales f se particiona en los vectores f, y fg.

Con esta particion segin los grados de libertad conocidos o desconocidos se ge-
neran las siguientes ecuaciones matriciales:

Koeas + Kopag —£,=0 (3.11a)
Kgaaa + Kﬁﬁag — fﬁ =0 (3.11b)

De la Ecuacion 3.11a se calcula el vector de desplazamientos nodales desconocidos
a,:
a, = K ! (f, — Kypas) (3.12)

3.2.3. Vector de fuerzas totales y reacciones en el soélido
A partir de la Ecuacién 3.11b se despeja el vector fg, asi:
fg = Kgaaa + Kggag (313)
El vector fg de acuerdo con la ecuacién 3.6 equivale a:

f5="F5+ £} (3.14)

Los vectores f'g y f/(Bn) son desconocidos y estan asociados con los desplazamientos

nodales conocidos. El vector f/(B") corresponde a las reacciones en los apoyos del sélido
y se obtiene de la siguiente forma:

£ =5 — 5 (3.15a)
£V = Kgaaq + Kgpag — 5 (3.15h)
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3.2.4. Extraccién de los componentes de desplazamiento, deformacion y
esfuerzo en el interior de cada elemento

El vector a = [ag ag}T corresponde a las componentes de desplazamiento en todos

los nudos de la malla de acuerdo a la numeracién de los grados de libertad. Cada
elemento finito tiene asociado un vector de desplazamientos nodales a'®, el cual
corresponde a las componentes de desplazamiento para los nudos del elemento. Este
vector al® se obtiene a partir de la extraccién de los coeficientes correspondientes a
los grados de libertad del elemento e. Tal procedimiento se representa como:

al® = E a] (3.16)

(e)

Con el vector de desplazamientos en los nudos del elemento al® se calculan los
desplazamientos en un punto en el interior del elemento utilizando la Ecuacion 3.27.
Asimismo, se obtiene la matriz de componentes de deformacién del elemento (¢, a
través de la matriz B (&,n, 1) mediante la Ecuacién 3.46, cuyo resultado es:

T

E(e)<€7777,u>:|:5xx Eyy €2z Yoy Vzz ’sz] (317)

Finalmente, utilizando la matriz constitutiva eldstica D definida en la Subsec-
cién 3.6.7 y €®), se calculan las componentes de la matriz de esfuerzo o(® utilizando

la siguiente ecuacion:
o€, p) = Del (3.18)

Las componentes de la matriz columna o(® con respecto al sistema coordenado
global son:

B (3.19)

a'(e)(f,n,,u):[am Oyy Ozz Ogxy Ogxz Oyz

3.3. Valores caracteristicos de esfuerzo y de deformacion

El estado de esfuerzos dado por sus componentes con respecto al sistema coordenado
global de la Ecuacién 3.19, permite obtener los esfuerzos principales oy, 05 v 03, los
cuales incluyen a los valores maximos y minimos de esfuerzo normal en un plano.
Los esfuerzos principales corresponden a los tres valores propios o, obtenidos como
solucién de la siguiente ecuacién matricial (Linero & Garzoén, 2010)

(»)

Oz Ozy Oz 1 00 Ny 0
Owy Oy Oy — |0 1 0| 0| [nP]| = |0 (3.20)
Opz Oyz Oz 0 01 n'P) 0
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El vector de coeficientes n® = [nip ) P P )]T corresponde a los vectores en las

direcciones principales obtenidos como los vectores propios de la ecuacién anterior.
Asimismo, el estado de deformaciones estd definido por seis componentes dife-
rentes, con respecto al sistema coordenado global zyz, como se muestra en la Ecua-
cién 3.17. A partir de este estado de deformaciones se determinan las deformaciones
principales ¢, de las cuales dos son aquellas deformaciones longitudinales de valor
méximo y minimo, que pueden actuar sobre una superficie (Linero & Garzén, 2010).
Estas deformaciones principales €, y sus respectivas direcciones m? = [mg(cp ) mP) m@ )]T
se obtienen al resolver el siguiente problema de valores y vectores propios:
1 1 (p)
Exa 5721/ 572,2 1 00 Mg 0
ey o sve| =0 1 0] g | [m®] =0 (3.21)
0 01 0

1 1
V22 3Vyz €2z mgp)

3.4. Criterio de von Mises

El criterio de fallo de von Mises establece que el comportamiento elastico de un
punto del sélido se mantiene si la densidad de energia de deformacién por distorsién
actuante es menor que la densidad de energia admisible del material (Linero et al.,
2020).

Si el material es dictil y su fluencia coincide con el limite de su rango eldstico, se
puede afirmar que el material tiene un comportamiento elastico siempre que o, <
oy, donde o, el esfuerzo de fluencia del material y o,,, es el esfuero de von Mises
actuante que se obtiene de la forma:

Ouvm = %\/(O’l —O'2>2+(0'1 —03)2+(02 —O'3>2 (322)

3.5. Valores promedio de esfuerzo y deformacién en los nu-
dos de la malla

Con el objetivo de mejorar la visualizaciéon de los resultados de esfuerzos y defor-
maciones en la malla de elementos finitos, se busca evitar grandes variaciones entre
los valores de los esfuerzos y deformaciones de los elementos consecutivos que tienen
nudos en comun, dentro de la malla de elementos.

A partir de los esfuerzos y las deformaciones calculados en el interior del elemento,
utilizando las funciones de forma se obtienen los valores de esfuerzos y deformaciones
evaluados en los nudos de cada elemento.
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Cada nudo de la malla que es compartido por méas de un elemento finito, va
a tener unos valores de esfuerzos y deformaciones provenientes de cada uno de los
elementos que lo contienen. Estos valores de esfuerzos y deformaciones en el nudo ¢,
que provienen de los elementos adyacentes son promediados, para luego designar el
resultado de este promedio como valor de esfuerzo o deformacién en el nudo.

Posteriormente se calculan los esfuerzos o deformaciones al interior del elemento
mediante las funciones de forma utilizando para ello los valores nodales promedio
previamente calculados. Este es un proceso que se conoce como suavizado y permite
representar los valores de esfuerzo o deformacion entre elementos adyacentes de forma
continua en toda la malla de elementos finitos.

En el siguiente ejemplo se considera que un nudo i es comtun a los elementos
finitos 1, 2 y 3, y que la deformacién normal gilm)(i), 5&?@.) y gii)(i), es evaluada para la
posicién del nudo ¢ en el interior de los elementos 1, 2 y 3, respectivamente. Primero
se calcula la deformaciéon normal promedio en el nudo ¢z como:

. Lo @ .o
Este procedimiento se repite en todos los nudos de la malla de elementos finitos.
Después se evalua la deformacién promedio &,, en el interior del elemento por la
. . : (e) .
interpolacién dada por sus funciones de forma N, y los valores de deformacién

promedio en los nudos &,,(;), asi:

ni

Eow =Y N9z, 3.23
D N

i=1

siendo ni el nimero de nudos del elemento finito.

3.6. Formulacion del método de elementos finitos para el
elemento hexaédrico de 8 nudos

Los conceptos presentados en esta seccion estan basados en el método de los elemen-
tos finitos aplicado a la mecénica elastica lineal utilizando el elemento hexaédrico
irregular de 8 nudos (Felippa, 2017a; Linero et al., 2020).

Asi como los elementos tetraédricos lineales son una expansion a tres dimensiones
de los triangulares lineales, los elementos hexaédricos de 8 nudos lo son a los cua-
drilaterales de 4 nudos. El elemento hexaédrico irregular de 8 nudos o simplemente
elemento hexaédrico es un poliedro de 6 caras, 12 lados y 8 nudos ubicados en sus
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Figura 3.1: Esquema y numeracién de nudos en el elemento hexaédrico y en sus formas simplificadas mas comunes:
(a) hexaedro irregular, (b) prisma, (c¢) pirdmide y (d) tetraedro.

vértices como lo muestra la Figura 3.1(a). Este elemento finito es el més simple de
la familia de los elementos isoparamétricos tridimensionales con forma de hexaedro.

Este tipo de elemento finito permite describir al menos diez tipos de volimenes
simplificados que resultan de modificar su geometria estindar (Dudley & Owen,
2014). Dentro de las formas mas comunes del hexaedro simplificado se encuentra el
prisma, el cual se obtiene superponiendo los nudos 3 y 4, y 7 y 8, como lo ilustra
la Figura 3.1(b). También se puede lograr la forma de pirdmide, superponiendo los
nudos 5, 6, 7 y 8, como se indica en la Figura 3.1(c). Asimismo, se puede producir
la forma de tetraedro superponiendo los nudos 3 y 4, y 5, 6, 7y 8 como se indica en
la Figura 3.1(d).

El elemento hexaédrico es usado ampliamente en simulacion numeérica de pro-
blemas con sélidos tridimensionales, siendo escogido en vez del tetraedro linear en
muchas situaciones (Dudley & Owen, 2014).

El nimero de nudos del elemento hexaédrico estd determinado por el orden de
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la funcién de aproximacion en su interior. El hexaedro de 8 nudos tiene una funcion
de aproximacién de orden trilineal. En cambio, los elementos hexaédricos irregulares
de 20 y 27 nudos, contienen funciones de aproximacién de orden superior. Particu-
larmente, este trabajo abarca el elemento finito de 8 nudos (Felippa, 2017a).

3.6.1. Numeracién de los nudos

Los ocho vértices del hexaedro son numerados del 1 al 8, conservando una secuencia
que garantice un valor positivo del volumen, utilizando el determinante del Jaco-
biano, como se muestra mas adelante. Esto se logra mediante las siguientes reglas de
numeracion:

e Tomar un vértice inicial y designarla como 1. Luego, seleccionar una cara a la
cual pertenezca este vértice, es decir, cualquiera de las tres caras adyacentes a
ella.

e Designar los otros tres vértices de la cara seleccionada en el item anterior con
los nimeros 2, 3 y 4, recorriendo los vértices en sentido anti-horario a un vector
normal a la cara seleccionada entrando al elemento.

e Nombrar el nudo 5 en el vértice de la cara opuesta que se conecta con una linea
al nudo 1.

e Escoger los demas vértices de la cara opuesta con los niimeros 6, 7 y 8, reco-
rriéndolos en sentido horario a un vector unitario a la cara opuesta entrando
al elemento.

En la Figura 3.1(a) se muestra el resultado de la aplicacién de las anteriores reglas
de numeracion.

3.6.2. Coordenadas naturales

Las coordenadas naturales para el elemento hexaédrico se definen con las letras grie-
gas £, n y u. Estas coordenadas van de una cara a la otra en cada uno de los tres
sentidos del elemento. Los valores que toman las coordenadas naturales son desde —1
en una cara, hasta 1 en la cara opuesta, a lo largo del elemento. Para el elemento del
ejemplo anterior las coordenadas naturales se muestran en la Figura 3.2 y quedarian
asi:

e ¢ toma el valor de —1 en el centro de la cara 1485 y +1 en el centro de la cara

2376.
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Figura 3.2: Coordenadas naturales en el hexaedro

e 7 toma el valor de —1 en el centro de la cara 1265 y +1 en el centro de la cara
3487.

e ;1 toma el valor de —1 en el centro de la cara 1234 y +1 en el centro de la cara
5678.

Las coordenadas naturales para los vértices, lados y caras del elemento finito se
muestran en la Tabla 3.1 (Felippa, 2017a).

3.6.3. Funciones de forma

Particularmente el elemento hexaédrico de ocho nudos esta conformado por un nudo
en cada uno de sus ocho vértices, de coordenadas (x;, y;, z;) y tres grados de libertad
por cada nudo, asociados a las componentes de desplazamiento uz(-e), Uge) y wz@. De
esta manera el elemento presentado tiene en total 24 grados de libertad, como se

muestra en la Figura 3.3.

La matriz de coordenadas globales de los nudos del hexaedro ¢(®), donde (z;, y;, %)
es la coordenada de cada uno de los nudos del elemento, corresponde a:
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nudo & 1 pu lado coordenada cara coordenada

1 -1 -1 -1 -2 n=-1, p=-1 1-4-8-5 E=-1
2 +1 -1 -1 223 &£=+41, p=-1 1-2-6-5 n=-—1
3 +1 +1 -1 34 n=+1, p=-1 1-2-3-4 pw=—1
4 -1 +1 -1 -4 &=-1, p=-1 2-3-7-6 §=+1
5 -1 -1 +1 -5 &=-1, n=-1 3-7-8-4 n=-+1
6 +1 -1 +1 26 £=+1, n=-1 5-6-7-8 p=+1
7 +1 +1 +1 37 E=+1, n=+1

8 -1 +1 +1 4-8 ¢=-1, n=+1

6 n=+41, p=+1
6-7 (=41, p=+1
-8 n=4+1, p=+1
5-8 &=-1, pu=+1

Tabla 3.1: Coordenadas naturales para el hexaedro: a la izquierda coordenadas de los nudos, al centro coordenadas
de las lados y a la derecha coordenadas de las caras.

() 1(37& ys Zs

Wg B\WT x7,y7’2’7
\

/2@7 Y2, ZQ)

© @

Figura 3.3: Grados de libertad del elemento hexaédrico
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MORMOENG
xée) NORNO
o i

=" Z() (3.24)
Ty ™ Ys ™ 25
0 40
ROEMOENG
)

Se considera el vector de desplazamientos nodales del elemento al® a la matriz
columna que contiene los desplazamientos en los nudos, como se muestra:

T
al® — [age” D AlT 1 lT } (3.25a)

T
al® — [u§e> o w@} (3.25b)

las componentes de desplazamiento u(®), v(¢) y w(®), en una coordenada (z, y, z) del
interior del hexaedro se obtienen a partir de la interpolacion de los valores nodales
(e) ( 9y w, ) de la forma:

/U/,L 3
W (g, 2) = NOU® § NOW® 4o N (3.26)
v (z,y,2) = Ng )'U§ ° Né‘e)vé AN Né )vé ) (3.26b)
w' (z,y,2) = Nge)wge) + Nge)wée) +-+ Née)wée) (3.26¢)

donde Ni(e) (x,y, 2) es la funcién de forma del nudo i del elemento e, evaluada en la
posicién (x,y, z).

La forma matricial del vector del desplazamiento en un punto de coordenadas
(x,y, z) en el interior del hexaedro puede obtenerse mediante:

u®(z,y, 2)=N©(z,y, 2)a® (3.27)

La matriz de funciones de forma del elemento hexaédrico puede expresarse en
términos de submatrices 3 x 3, asi:

NO= NP N N (3.282)
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siendo,
N, 0 0
N9=10 N, 0 (3.28D)
0 0 N

En consecuencia la matriz de funciones de forma tiene 3 filas por 24 columnas y
corresponde a:

N9 0o o N2 0 0 N 0 0
NO=|o0 N9 0 0o N o0 0 N o0 (3.28¢)
o 0o N 0o o N? o 0 0 N7
Las ocho funciones de forma asociadas a cada nudo del elemento Ni(e) son las
siguientes:

N = (1= )1~ )1~ p) (3.290)
N = S+ - )1 - p) (3.20b)
NP = 1+ (1 + )1~ p) (3290
NP = (1= + )1~ p) (3.29d)
N = S0 -1 - m)(1+p) (3.29)
N = S+ = )1+ p) (3.201)
N = L1461+ n)(1+ ) (3.298)
N = (=90 +m(1+p) (3.29h)

Estas funciones de forma se pueden resumir en la siguiente expresion:
N = é(l —&&) (14 mm) (1 + ) (3.30)

donde &;, n; v p;, son las coordenadas naturales del ¢-ésimo nudo.
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3.6.4. Matriz de operadores diferenciales con respecto al sistema natural
actuando sobre funciones de forma

Las derivadas parciales de las funciones de forma del elemento hexaédrico con respec-
to a las coordenadas cartesianas, se obtienen utilizando la regla de la cadena. Dicha
operacion diferencial en el espacio tridimensional corresponde a:

ON¢ N e ON;Oy | ONfou
o S = et T o T o os (3:31a)
ON? _ONFOE  ONfdn  ONEp
ON? ONEO¢  ONEOy  ONE
=i ! - 31

Reescribiendo las ecuaciones anteriores en forma matricial y definiendo a Hgf)) como
la matriz columna que contiene las derivadas de las funciones de forma en sistema

global para cada nudo 7, se tiene que:

(&) _ 1-1 1
H(i) =J7 By (3.32)
siendo:
ONg % On O ON;
ox or Ox Oz o&
(e) _ | onyg -1 _ |oe oy ou 3, — | ON?
Ho = 1% T7=1% & o Bo =5 (3.33)
o o on o ON
0z 0z 0z 0z o

Donde ﬁ(i) (&,m, i) es la matriz reducida de operadores diferenciales con respecto
al sistema natural actuando sobre las funciones de forma del nudo i. La matriz J
de tamano 3 x 3 corresponde al inverso del Jacobiano de las coordenadas cartesianas
(x,y, z) con respecto a las coordenadas naturales (&, 7, ).

Asimismo, la matriz de 3 X 8 que contiene las derivadas de las funciones de
forma en sistema global del elemento finito H® esta conformada por las submatrices

e

columna HEZ)) de cada nudo, asi:

HE© — H(e) H(E) H(e)

m Hg - Heg (3.34)

De igual forma, la matriz de operadores diferenciales actuando sobre las funciones

de forma en sistema coordenado natural B(e) para el elemento finito, tiene tamano
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e

3 X 8 y esta conformada por las submatrices columna B (i) de cada nudo, de la forma:

5 _ [0 5@ - (@)
BY =8 B - B (3.35)

La matriz Jacobiana estd definida como:
J=8"¢O (3.36)

siendo c la matriz mostrada en la Ecuacion 3.24 y J la matriz mostrada a continua-
cion:

oz By 0z
o 9 ¢
— | o b
=% o o (3.37)
ox oy oz
ou  Ou  Ou

Para el calculo de la matriz Jacobiana se requiere derivar parcialmente cada una
de las 8 funciones de forma para &, n y u, como se muestra de forma general en la
Ecuacion 3.31a, conformando la matriz ]3(5 .M, it). Dicha matriz estd conformada por
los siguientes términos:

ON1(&mp) . ONs(&mm)
o€ D€
B (¢, )= | Ml . OMaltnan (3.382)
ON1(Empr) .. ONs(&mip)
Op Op 3x8
© —I=n)l-p) Q=-n)1-p) A+n)d-pn) —A+n)1-p
B = |-1-90-p) -1+HQ-p) A+HA-p) (1= —pn)
—1-9(0-n) -1+HA-n —-1+H1+n —-(1-E1+n)

(1= +p) Q-n+p) A+n)d+p) —A+n1+p
1= +p) —1+H0+p) T+HA+p) A=+ p)
(1= -n) (1+HH(1-n) A+A+n) (A=A +n)

(3.38b)

3.6.5. Matriz Jacobiana y su inversa

La coordenada global de un punto (z, vy, z) en el interior de un elemento finito isopa-
ramétrico estd definida por las coordenadas (z;,y;, 2;) de sus nudos i = 1,...,nn de
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la forma:
r = Z%Nf y = Z yiINY z = Z x; Nf (3.39)
i=1 i=1 i=1

En particular, el nimero de nudos del elemento hexaédrico es nn = 8.
De esta manera, al realizar el producto entre B con la matriz de coordenadas de
los nudos c, se conforma la matriz J, la cual se puede representar como:

ON? ON?¢ ONE
— ON¢ ON¢ ON¢
J = D i Ti an > i Yi o o 2 o (3.40)

nn ON? nn ON? nn ON?
D im Ti EM D ict Yiou D e Zi I

A continuacién se muestra un procedimiento para calcular la inversa de la matriz
J, el cual es una simplificaciéon del método de cofactores (Felippa, 2017a):

il Q12 ais 1 A A As ’
A= |an axn axs|, A~ = m Aoy Ay Asg (3.41)
@31 azz2 asz3 Azt —Asp Asg
donde:
A1 = aszazz — azsazs, (3.42a)
Agz = aszan — azass, (3.42b)
Asz = anag — aas, (3.42¢)
A1z = agaz — azaszs, (3.42d)
Aoz = azia1z — aza11, (3.42¢)
Az1 = arza3 — aizas, (3.42f)
Ag1 = azga13 — a12a33, (3.42¢g)
Azz = aizag; — agsan, (3.42h)
A1z = azia2s — aziazs, (3.42i)
|A| = an A + a2 A2 + a3 Az (3.42j)

Con la inversa de la matriz Jacobiana J~' y con la matriz E(i), utilizando la Ecua-

cién 3.32 se calcula la matriz HEZ@))
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3.6.6. Matriz de operadores diferenciales actuando sobre las funciones
de forma

La matriz de operadores diferenciales V para problemas de la mecanica estructural
tridimensionales con deformaciones infinitesimales, contiene las derivadas con res-
pecto a los ejes coordenados globales y esta definida como (Linero et al., 2020):

(3.43)

o flodle © o8k

Yo o Blo oSl ©
Shtl ofle o o

La matriz columna de la deformacién €' en notacién de ingenierfa de un elemento
finito tridimensional e, es de la forma:

T
5(6) = |:8zz Eyy €2z Voy Vzz ’7y2] (344)
La relacion entre el campo del desplazamiento y el campo de la deformacion en
el interior del elemento finito es de la forma:

e = vu (3.45)

Reemplazando la Ecuacion 3.25 que define a la matriz columna de desplazamien-
tos nodales a® en la expresién anterior, se obtiene que:

e® = Vu® = VN©@a® = B@a® (3.46)

La matriz de operadores diferenciales actuando sobre funciones de forma en coor-
denadas globales B para el elemento hexaédrico se expresa como:

ONY ONS INE
5= 0 0 22 0 0 5= 0 0
ON§¢ ON§ ON§
0 %L 0 0o ZE o0 - 0 ZE 0
ONE¢ ONS ONE
0 0 L0 0 2 0 0 8
B(e) — 0z 0z 0z (347>

ONy  ON¥ 0 ONS  ON§ 0 ... ON; ONg 0
dy ox oy ox oy ox

ONY 0 ONy  ONS§ 0 ONS§ ... ONg 0 ONE
0z ox 0z oz 0z o
0 ONy  ONy 0 ON§S  ONS§ . 0 ONE  ONE

L 0z dy 0z dy 0z oy
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La matriz B indicada en la ecuacién anterior estd conformada por 8 submatrices

BE?), asociadas a cada nudo i, asi:

B© — [BH B®

(e)

donde,

£
0
0 _ |0
o0 |nt
By}
0

En consecuencia,
(BY 0 0
0 BY 0
B |0 0 BY
COBY B o
By 0 By
| 0 By By

(e)
0 0

BY) 0
0 BY

By 0
0 BY

By B

BYY
0
0

8 8
BY B 0

8
By
0

(8)
B
d6x3
0 0
8
BY 0
8
0 BY

0 BY
8 8
By B |

6x24

(3.48a)

(3.48D)

(3.48c¢)

Para conformar la matriz B se utilizan las componentes de la matriz H®,
mostrada en la Ecuacién 3.34. A continuacién se muestran los coeficientes corres-

pondientes al nudo i de la matriz B(®):

5 ONy e Z.
B%l) = 8_371 = BuJy' + BayJp,' + By Jig' = H1()
g _ ONL_ON1DE | ONi O | ONOp _ o
W= 9 — 8¢ dxr ' On 0x  Op oz
gy = 9Nt _ ON\ OC | ON\On  ON\Op _ pa
20y 9cdy ooy opoy P

(3.49a)

(3.49b)

(3.49c¢)
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BY) = % = 88—]?% aa]:; ! % aaNu ! g—i‘ = HY) (3.49d)

Bil=0 BY=0 BY=0 BY)=0 BY=0 (3.49¢)
BYy=0 B{=0 Bl)=0 BY=0 (3.49f)

Byl = Hy Byl = Hy (3.49)

By =HY)  BY =HY) (3.49h)

BY =Hy) By =4y (3.491)

3.6.7. Matriz constitutiva del material elastico lineal isotrépico

La matriz constitutiva D de un material elastico lineal isotrépico con relacién de
Poisson v y médulo de Young E, se define como se muestra a continuacién (Linero
et al., 2020):

(3.50)

3.6.8. Matriz de rigidez del hexaedro

A partir de la aplicacién del Principio de los trabajos virtuales al método de los
elementos finitos para problemas mecénicos estaticos tridimensionales, se tiene que
(Felippa, 2017b; Linero et al., 2013; Zienkiewicz, 2013):

Z (5a{6)K(e)a(e) — Z 53%;)%(6) - 5ag;)f(") =0 (3.51)
e=1 e=1

En la anterior ecuacion, f es la suma del vector de fuerzas nodales equivalentes a
la accion de fuerzas de superficie f con el vector de fuerzas nodales equivalentes a
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la accién de fuerzas de cuerpo f,, los cuales se mostraran desde la Subseccién 3.6.9
hasta la Subseccién 3.6.12. En cambio, el vector £™ contiene las fuerzas aplicadas
directamente en los nudos de la malla y se explicard en la Subseccion 3.6.13. K© se
define como la matriz de rigidez del elemento finito, que corresponde a la siguiente
integral de volumen:

K — /V _B{,D( B dV (3.52)

donde By corresponde a la matriz de operadores diferenciales actuando sobre las
funciones de forma mostrada en la Subseccion 3.6.6. D es la matriz constitutiva del
material, como se muestra en la Subseccion 3.6.7.

La integral en el volumen del elemento finito se evalia en las coordenadas natu-
rales £, n v p indicadas en la Subseccién 3.6.2, definiendo al diferencial de volumen
dV, asi:

dV = dz dy dz = det J'© d¢ dn du (3.53)

siendo det J© el determinante de la matriz Jacobiano. En consecuencia la matriz de
rigidez de un elemento finito tridimensional es de la forma:

1 1 1
K© = / / / B, D) B detJ® d¢ dn dps (3.54)
—-1J-1J-1

La integral anterior se calcula numéricamente utilizando el método de la cuadra-
tura de Gauss (Zienkiewicz, 2013). Esto se logra a través de una sumatoria ponderada
de la funcién por los coeficientes w;, w; y wy de cada eje coordenado natural, eva-
luada en coordenadas especificas (&;,n;, ix), conocidas como puntos de Gauss. La
aproximacién de la integral depende de la cantidad de puntos de Gauss ni, nj y nk,
establecidos para los ejes &, n y i, respectivamente. Por lo tanto, la matriz de rigidez
de un elemento finito tridimensional es aproximadamente igual a:

ni nj nk

K = Z Z Z wiwjwr Bl (&5, 1) D By (&, my, i) det (&, my, ) (3.55)

i=1 j=1 k=1

La ecuacién anterior puede simplificarse a una sola sumatoria, de la forma:
ng
K© = "w, B{) (& 1. t1g) D Bie) (& 0gs 11g) detT (&g, mg, p14) (3.56)
g=1

donde wj es el coeficiente de ponderacién simplificado y (&,,7,, it4) €s la coordenada
natural en un punto de Gauss g.
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(a)ng=1x1x1=1 (b)) ng=2x2x2=38
Pg & Mg Mg W pg & Mg Iig

Gl 0 0 0 4 Gl —/1/3 —/1/3 —\/1/3
G2 ++/1/3 —/1/3 —/1/3
G3 +/1/3 +/1/3 —/1/3
G4 —\/1/3 +/1/3 —/1/3
G5 —/1/3 —/1/3 +/1/3
G6 +/1/3 —/1/3 +/1/3
G7 +/1/3 +/1/3 +/1/3
G8 —/1/3 +4/1/3 +4/1/3

Tabla 3.2: Coordenadas naturales y coeficientes de ponderacién del método de la cuadratura de Gauss para un
elemento finito hexaédrico, considerando: (a) 1 x 1 X 1 = 1 punto de Gauss y (b) 2 x 2 X 2 = 8 puntos de Gauss.

&
Q

— = = = = e

El primer orden completo de aproximacion de la integral corresponde a un punto
de Gauss ng = 1 x 1 x 1 = 1, cuya coordenada y coeficiente de ponderacion se
indica en la Tabla 3.2(a). El segundo orden completo de aproximacién se obtiene
utilizando 2 puntos de Gauss asociados a cada coordenada natural, es decir un total
deng =nixnjxnk =2x2x2 =8 puntos de Gauss. Las coordenadas y coeficientes
de ponderacién de este orden de aproximacién se presentan en la Tabla 3.2(b). El
tercer orden completo de aproximacion evaltia las sumatorias en 3 puntos por cada
eje natural, para un total de ng = ni x nj x nk = 3 x 3 x 3 = 27 puntos de Gauss.

En la Figura 3.4 se muestra la ubicacion de los puntos de integracién de Gauss
para ng = 1 y ng = 8 (Felippa, 2017a). Al igual que en la Tabla 3.2, G1, G2, ...,
G8, indican los puntos de Gauss en cada orden de aproximacion.

La matriz de rigidez de un elemento hexaédrico de 8 nudos alcanza una apro-
ximacion satisfactoria para ng = 8, utilizando el método de integracién numérica
de Gauss (Felippa, 2017a). Razén por la cual, en este trabajo se implementé dicho
orden de aproximacion sobre el elemento finito.

3.6.9. Vector de fuerzas equivalentes a la accion de fuerzas de cuerpo en
el elemento

El vector de fuerzas equivalentes a la accion de fuerzas de cuerpo en el elemento

~(e) ) . ., . z(e)
f, ", asi como el vector de fuerzas equivalentes a la accién de presiones f, °, el cual

S )
se analizara en las siguientes secciones, proviene de la Ecuacion 3.51. Estos vectores
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Figura 3.4: Distribucién de los puntos de Gauss para el elemento hexaédrico de 8 nudos a)l punto b)8 puntos

)
conforman al vector £ °, asi:

#(

i -9 L £ (3.57)

El vector f'l(,e) corresponde a las fuerzas equivalentes a la accién de las cargas por
unidad de volumen, producidas por las fuerzas maésicas en el interior del elemento
finito.

Al igual que en el calculo de la matriz de rigidez, el diferencial de volumen del
elemento hexaédrico es dV = dx dy dz = detJ(® d¢ dn du, por lo que resulta:

~(e) +1 e+l el
£, = / 1 / e N{ b detd d¢ dn dp (3.58)

siendo by el vector de fuerzas de cuerpo, el cual contiene las componentes de la
fuerza por unidad de volumen del elemento en cada direccion global, asi:

T
b =[BT BT . BT (3.59)

1x24
siendo

T

b = [biw biy bis] (3.59D)

Considerando que las cargas por unidad de volumen corresponden al peso propio
del material, orientado en direccién —y y con peso especifico v (Figura 3.3), se tiene:
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b =0 — 0] (3.60a)
por lo tanto el vector b para el elemento hexaédrico es de la forma:
(e) — — e — r
b =10 —y 0 0 = 0], (3.60b)

De manera similar al calculo de la matriz de rigidez, esta integral triple se puede
calcular utilizando el método de integracion numérica de Gauss, asi:

ng

7o) e

f,” = E :wg N@)(ﬁgmg,ug)b@) detJ’ )<fg7ngaﬂg) (3.61)
g=1

donde w, es el coeficiente de ponderacion simplificado, (&,,n,, f1y) €s la coordenada
natural en un punto de Gauss g y detJ (e) (€, Mg, 14g) corresponde al determinante del
Jacobiano mostrado en la Subseccion 3.6.5.

3.6.10. Vector de fuerzas equivalentes a la accién de una presién unifor-
me en sistema coordenado global

() . . . L
El vector £, es un vector que contiene las fuerzas equivalentes debidas a una presion
uniforme p(®), referida al sistema de coordenadas global. Esta presién uniforme puede
actuar sobre una o varias de las nc caras del elemento hexaédrico, de la forma:

~(e) T — =(e)(©)
£, = | N{pedS=> f (3.62)
c=1

T(e)

. =(e)(0) . ., . .
siendo, f, el vector de fuerzas equivalentes a la accién de una presién uniforme
sobre el area de la cara Aée), definido como:

FOC_ /A  NLplds (3.63)

. : @)
Este vector esta conformado por subvectores asociados a cada nudo f_;" °, asi:

£ = (3.64)
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donde cada subvector es de la forma:

o) = NG pldA (3.65)

1
Ale

s e 2z
En esta ecuacién, pg ) es el vector de componentes de presién sobre la cara ¢ en

sistema coordenado global, expresado como:

e

pl) = | pi (3.66)

P

Sustituyendo las funciones de forma del elemento, se obtienen las fuerzas equiva-
lentes en los nudos debidas a la presion pge), asi:

Dzc
(e) | —
Lo A9 i=1,2,3,4,56,7,8

o] 6= (1234)(1265)(3487)(2376)(1584)(5678)
Pzc

Se observa que dicha presién es equivalente a una fuerza de igual magnitud en cada

uno de los nudos de la cara ¢ donde esta aplicada.
()

en los nudos del elemento que no estan

contenidos en la cara ¢, la fuerza debida a la presion p((f) es igual a cero. Por ejemplo,

Cabe mencionar que para cada f

=(e)(1234
para una presién actuando en la cara (1234) el vector fS)( ) contiene las fuerzas
equivalentes a la presion actuando tnicamente en los nudos 1, 2, 3 y 4.

~021) A, g

f, -4 [pg)% pge2)34 p§e2)34 p§€2)34 00O O}lx%

donde

(e) (e) (e)

() _ _
Pi234 = [ 21234 Dy1234 pz1234} , 0= [0 0 O]

De igual manera, para una presién uniforme pge) referidas al sistema global de

=(e)(1265
coordenadas actuando sobre la cara (1265), el vector fii)( ) es:

(e)
201265 Ajses [ (e e : ; .
f, T4 [p§2)65 Pio%s O O iy Piys O O} 1x24

donde

(e)

(e) e e _
Pi2es = [p;1)265 pg(;l)265 pzl265i| , 0= [O 0 O]
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F(e)(1265)

nb

5

#(1265)
z5 f.(1265)

(e)(1265
o) (1265)

'f'-(e)(1265)
n2 %(1265)
22

Figura 3.5: Presién uniforme normal que entra a la cara 1-2-6-5 del hexaedro: (a)vector normal entrando a la cara,
(b) presién uniforme normal que entra a la cara, (c) fuerzas equivalentes en direccién normal, y (d) componentes de
las fuerzas equivalentes en sistema coordenado global.

3.6.11. Vector de fuerzas equivalentes a la accién de una presion unifor-
me normal a una cara del elemento

La cara ¢ de un elemento finito e tiene un vector normal unitario a su superficie ngg

entrando al elemento, como se muestra en la Figura 3.5(a), el cual estd definido en
coordenadas globales asi:

T
n® — [ngf) n?(f) ngC)] (3.68)
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Con este vector es posible transformar la presién pgfc) mostrada en Figura 3.5(b) a

fuerzas equivalentes aplicadas en cada uno de los ¢ nudos de la cara como se muestra
en Figura 3.5(c), en donde cada componente de fuerza en el nudo equivale a:

N 1
ffﬁ)(c) _ Zpﬁfc) Aﬁfc) (3.69)

De esta manera, el subvector de fuerzas equivalentes en el nudo i de la cara ¢ con
respecto al sistema coordenado global es:

£ = fOen© (3.70a)
@0 0@ © (© _(]F
fo = u [n ny’ ] (3.70b)

Para obtener el vector de fuerzas equivalentes completo f’ie)(c) correspondiente a
la presion normal a la cara ¢ del elemento e, cuyas componentes se muestran en la
Figura 3.5(d), se considera que en los nudos del elemento que no hacen parte de la
cara c, la fuerza equivalente es igual a cero.

Por ejemplo, si se aplica una presién normal a la cara (1265), el vector de fuerzas
~(e)(1265
equivalentes completo fi )(1269) es

=(e)(1265) 1 (¢ . . . . . .
fs 21p21)26514§2)65 [n§2)65 ni% O O n%; niy; O OLxM (8.71)

donde

ngz)65 = [”551)265 ”561)265 ”261)265} , 0= [O 0 O]

Para el calculo del vector unitario normal n((f) que entra a la cara (1265), se puede
seguir el siguiente procedimiento (Linero et al., 2020):

(12) (15)

e (Calcular los vectores unitarios m'**) y m'*°)| los cuales determinan la direccién
de los lados 1 —2 y 1 — 5 y hacen parte de la cara cargada (1265).

e Calcular el vector normal a la cara cargada (1269 mediante la operacién

7(1265) _ 111 (12) o 17 (15)

e Calcular el vector unitario m(!¥, quien define la direccién del lado 1 —4, el cual
no pertenece a la cara cargada (1265). Esto para garantizar que la direccién

del vector normal a la cara cargada sea entrando al elemento.
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e Definir la direccion del vector normal entrando al elemento ast:

265 [(1265) o 51265) (1) < 57
n T ) 0265 51265 . (1) ~ g (3.72)
e Normalizar el vector n'2%%);
~ (1265)
n029) = & (3.73)
ﬁ(1265)’

e El vector normal unitario n"2%) referido al sistema de coordenadas global zyz
es:

T
n(1265) _ [%1265) 1 (1265) ng1265)] (3.74)

3.6.12. Vector de fuerzas equivalentes a la accion de una presion hidro-
estatica

Se define la presion causada por el agua sobre la superficie de un sélido en funcion
de su profundidad en direccién y (Linero et al., 2020), como:

w hw - i hw
P = {’y (o —y) siy < (3.75)

0 Slyzhw

Siendo 7, el peso especifico del agua y h,, la posicién maxima del agua con respecto
avy.

La presion pgf;l), se considera uniforme en la cara del elemento finito e y se evalia
a la profundidad yée) del centroide de dicha cara. Por lo tanto la presién unifor-
me normal que actua en la cara del elemento finito e donde interviene una presién
hidrostatica es:

w hw_ £€) i ((:e)<hfw
(e) _ {’Y ( ye') siy (3.76)

e 0 si yée) > hy

Para el calculo de las fuerzas en los nudos equivalentes a la accién de una presion

uniforme normal a una cara del elemento se utiliza el procedimiento indicado en la
Subseccion 3.6.11.
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3.6.13. Vector de fuerzas aplicadas directamente en los nudos de la malla

Este vector denominado f (”), contiene todas las fuerzas aplicadas directamente a los
nudos de la malla, cada una de las cuales estd asociada a un grado de libertad. Este
vector se utiliza para formar el vector de fuerzas nodales totales de la malla f, como se
muestra en la Ecuacion 3.6. Asimismo. contiene tanto las fuerzas conocidas, las cuales
estan asociadas a los grados de libertad desconocidos, como las fuerzas desconocidas
o reacciones, asociadas a los grados de libertad conocidos, como se muestra en la
Seccion 3.2.

3.7. Formulacion del método de los elementos finitos para el
elemento prisma o cuna

Para el enmallado de algunos sélidos, de acuerdo a su geometria es conveniente
utilizar alguna de las formas modificadas del hexaedro. En esta seccién se muestra una
de las formas modificadas del elemento hexaédrico, el pentaedro, también conocido
como prisma o elemento tipo cuna.

Esta geometria complementa adecuadamente al elemento hexaedro cuando se
requiere el enmallado de algunos tipos de sélidos con formas cilindricas o similares.

El elemento tipo prisma se obtiene cuando dos parejas de nudos del elemento
hexaédrico se fusionan, tal como se muestra en la Figura 3.1(b). Esto genera un
elemento de 6 nudos, 9 lados y 5 caras.

Debido a estos cambios en la geometria del elemento hexaédrico original, es ne-
cesario modificar las funciones de forma (Zienkiewicz, 2013).

3.7.1. Numeracién de los nudos

Se considera que las parejas de nudos 3 —4 y 7 — 8 de la geometria original se unen,
por lo que es conveniente renombrar los nudos, como se muestra en la Figura 3.6. La
reglas de numeracion de los nudos del elemento prisma son las siguientes:

e Tomar un vértice inicial y designarlo como 1, luego seleccionar una cara trian-
gular a la cual pertenezca ese vértice.

e Designar los otros tres vértices de la cara seleccionada en el item anterior con
los nimeros 2 y 3, recorriendo los vértices en el sentido anti-horario de un
vector normal a la cara seleccionada entrando al elemento.

e Designar el nudo 4 en el vértice de la cara opuesta que se conecta con una linea
al nudo 1.
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Figura 3.6: Numeracién de los nudos y coordenadas naturales en el elemento prisma

e Designar los demas vértices de la cara opuesta con los ntumeros 5 y 6, reco-
rriéndolos en sentido horario a un vector unitario a la cara opuesta entrando
al elemento

3.7.2. Coordenadas naturales

El elemento prisma presenta tres caras cuadrilaterales de cuatro nudos y dos caras
triangulares de tres nudos, como se muestra en la Figura 3.6. Por esta razén, la
funcion de aproximacién en un punto estd definida por una interpolacién lineal en
coordenadas naturales en las direcciones £ y 7, y una interpolacién isoparamétrica
lineal en la direccion p (Zienkiewicz, 2013).

La Figura 3.6 indica las coordenadas naturales (£, 7, i) de los nudos del elemento
prisma y el origen de cada eje coordenado. Particularmente, las coordenadas naturales
¢ y n toman valores entre 0 y 1, siendo £ = 0 en el nudo 1 y £ = 1 en el nudo 2.
Asimismo, 7 es igual a cero en el nudo 1 y corresponde a 1 en el nudo 3. Por otro lado,
la coordenada natural 4 es igual a —1 en los puntos sobre la cara (123), mientras que
toma un valor de +1 en los puntos sobre la cara (456). Las coordenadas naturales
para los nudos, lados y caras del elemento finito se muestran en la Tabla 3.3.

Al igual que el elemento hexaédrico de ocho nudos, el prisma estd conformado
por un nudo en cada uno de sus seis vértices de coordenadas (z;,y;, 2;). Cada nudo
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nudo & 1 W lado coordenada cara coordenada
1 00 —1 1-2 n=0pu=-1 1-3-2 pw=—1
2 1 0 —1 1-3 E=0,p=-1 4-5-6 p=+1
3 01 -1 23 ¢=1n=1Lp=-1 1-2-5-4 n=20
4 00 +1 4-5 n=0,p=1 1-4-6-3 =0
5 1 0 +1 4-6 E=0,p=1 2-3-6-5 ¢(=1n=1
6 0 1 +1 6 E=1n=1Lpu=+1
1-4 E=0,n=0
2-5 E=1,n=
3-6 E=0,n=

Tabla 3.3: Coordenadas naturales para el prisma: a la izquierda coordenadas de los nudos, al centro coordenadas de
las lados y a la derecha coordenadas de las caras.

tiene tres grados de libertad, asociados a las componentes de desplazamiento u(e)

(e) y w, () Por lo tanto el elemento prisma tiene en total 18 grados de libertad, como

se muestra en la Figura 3.7.

3.7.3. Funciones de forma

matriz uncion rm men risma e 3 conform r
La matriz de funciones de forma del elemento sma e estd conformada por las
submatrices Nge) asociadas a cada nudo ¢, ast:

N = INl® N ... N (3.77a)
siendo,
N 00
NO=| g NO (3.77b)
o0 0o N©

(2

Por lo tanto, N(®) es una matriz de 3 filas y 18 columnas con los siguientes términos:

N9 o o N2 0o o0 -+ N? 0 0
NO=1o0 N9 0o o N2 0 - 0 N 0 (3.77¢)
o o N? 0o o N 0 0 N

3x18

Las seis funciones de forma del elemento prisma en funcién de las coordenadas
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Ne
6
wée) o (6, Y6, 26)
(e)
YA
Us
(x4, ya, 24)1
Wy Y
v, €
(Ilaylazl) P
Ve
(e) (e)
w U T2, Y2, 22)
1 1 /2&
wée) uge)
Figura 3.7: Grados de libertad del elemento prisma
naturales son:
0 _ 1
N = L1 — €= n)(1 — p) (3.780)
. 1
Ny = 56— ) (3.78b)
(@ _ 1
N = (1 = ) (3.75¢)
. 1
N = 51— =)+ p) (3.784)
. 1
N = SE1+4) (3.78¢)
. 1
N = Sn(L+ p) (3.78f)

Se observa que al reemplazar las coordenadas naturales de un nudo en su funcién
de forma correspondiente, el resultado es 1, lo cual es una de las propiedades de las
funciones de forma (Zienkiewicz, 2013).
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3.7.4. Matriz de operadores diferenciales con respecto al sistema coor-
denado natural actuando sobre funciones de forma

Las derivadas parciales de las funciones de forma con respecto a las coordenadas
cartesianas se obtienen mediante la regla de la cadena, de la forma mostrada en
la Ecuacion 3.31a. Al reescribir estas ecuaciones de forma matricial, se definen las
matrices H®), J ~1(e) y B(e), como se muestra en la Ecuacién 3.32. Las matrices H(®)
y J 1) se muestran en la Subseccién 3.7.5.

La matriz B(e) es la matriz de operadores diferenciales actuando sobre las funcio-
nes de forma en sistema coordenado natural para el elemento prisma, tiene tamano
3 x 6 y esta conformada por las submatrices columna EE:)) de cada nudo, de la forma:

5 [nle) 5@ 5 (€)
B = By, By - By (3.79)

Al reescribir las anteriores ecuaciones en forma matricial, se tiene que:

8N1(§,T],M) . 8N6(§7777M)
(e) « .
BY(E )= |20 .. ONeltnn) (380)
ONi(&mp) . ONs(&mm)
ou op 3x6

Estas derivadas parciales de las funciones de forma corresponden a:

aé\gl _ g - % 85\22 _ % B g 56]\573 ~0 (3.81a)
@ajf b % 35\;5 o, aajf _ % L (3.81c)
8(;:775 e % 851775 o, 3(;:7766 by % (3.81d)

Por lo tanto la matriz B(e) para el elemento prisma es:
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NI= N
M

N[

>

—

9]

N
NE T

(3.82)

wim . O
SIS
+ o
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N [

+

IS
|

N | =
|

(o178
S
—
N
e

s

3.7.5. Matriz Jacobiana y su inversa

La matriz Jacobiana se calcula como el producto entre la matriz B(e) y la matriz c(®
como lo indica la Ecuacién 3.36. Esta ltima corresponde a la matriz de coordenadas
en los nudos de un elemento prisma y estd definida como:
i N
e e e
x z
2 (3.83)
donde x;, y; v z; definen la posiciéon de cada nudo ¢ del elemento en coordenadas
globales.

A partir de la Ecuacién 3.40, se observa que la matriz Jacobiana tiene la misma
dimensién (3 x 3) tanto en el elemento hexaédrico como en el prisma, ya que su
dimensién no depende del nimero de nudos del elemento. Por lo tanto, se aplica el
mismo procedimiento para calcular su inversa presentado en la Subseccién 3.6.5.

La matriz H® se obtiene utilizando la matriz B(e) y el inverso del Jacobiano,
como lo indica la Ecuacién 3.32. El resultado corresponde a una matriz conformada

()

por submatrices H(z) asociadas a cada nudo asi:

© _ [e© 1o  q©
HY = |H;y) Hpy, H

(3.84)
3.7.6. Matriz de operadores diferenciales actuando sobre las funciones
de forma

La matriz de operadores diferenciales con respecto a las coordenadas globales ac-
tuando sobre las funciones de forma de un elemento prisma B es:

B® — [B® B© B®

m B o B (3.85a)
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la cual estda conformada por submatrices Bgf)) asociadas a cada nudo 7 y definidas

como: ~ _
BY 0 o
o BY o
o o0 BY
B! = 53 (3.85h)

B B 0
B0 B
i

6x3

)

Los términos de la matriz B§€ se obtiene a partir de las componentes de la matriz

ng), como se muestra en la Ecuacién 3.49.
De acuerdo a lo anterior, la matriz B tiene 6 filas y 18 columnas con los si-
guientes coeficientes:

BY o o ... B9 0o o
o BY o ... o BY o
o o BY ... o o BY
Al ; 6) ) ; (3.85¢)

1 1 6 6
BY o BY ... BY% o BY
1 B0 6)  p6)

0 By By ... 0 By By

3.7.7. Matriz de rigidez del elemento finito

El procedimiento para obtener la matriz de rigidez del elemento finito prisma o cuna
es similar al del elemento hexaédrico mostrado en la Subseccién 3.6.8. La diferencia
estd en: (i) la matriz de operadores diferenciales actuando sobre funciones de forma
dada en la seccién anterior y (ii) la ubicacién y el coeficiente de ponderacion de los
puntos de Gauss del proceso de integracion numeérica.

Particularmente en este trabajo se aproxima la integral de la matriz de rigidez
utilizando ng = 6 puntos de Gauss G1, G2, ..., G6. La posicién en coordenadas
naturales (£;,1,, 1tg) ¥ €l coeficiente de ponderacion w, de dichos puntos se indican
en la Figura 3.8 y la Tabla 3.4 (Kohnke, 2009; Zienkiewicz, 2013).
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2

Figura 3.8: Distribucién de los 6 puntos de Gauss en el elemento tipo prisma

Tabla 3.4: Puntos de Gauss para elemento prima o cufia y sus coeficientes de ponderacién

pg & ny Hg Wy
1 1 1 1
Gl 6 6 3 6
2 1 1 1
G2 3 6  \/3 6
1 2 1 1
G3 5 3 3§
1 1 1 1
G4 6 6 3 6
2 1 1 1
G5 3 6 3 6
1 2 1 1
G6 5 3 3 6
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3.7.8. Vector de fuerzas equivalentes a la accion de fuerzas de cuerpo en
el elemento finito

El vector de fuerzas equivalentes a la accion de fuerzas de cuerpo en el elemento
prisma se obtiene de la Ecuacién 3.61. Particularmente, el vector de fuerzas de cuerpo
b contiene las componentes de fuerza por unidad de volumen en las direcciones
globales, organizadas por subvectores asociados a cada nudo bge), asi:

T
b = [T BT . b (3.862)
1x18
siendo,
bl = [bi by bi]" (3.86b)

Las fuerzas por unidad de volumen corresponden al peso propio del material en
direccion —y, con peso especifico . Por lo tanto, los subvectores por nudo se definen
como:

b =0 — 0]" (3.87a)
de esta manera, el vector b'® para el prisma es:
b =[0 =y 0 -+ 0 —y 0], ., (3.87h)

3.7.9. Vector de fuerzas equivalentes a la acciéon de una presiéon uniforme
en sistema coordenado global

El vector de fuerzas equivalentes a la accién de un presién uniforme en sistema coor-
=(e) , .

denado global sobre todas las caras de un elemento f_ " esta definido por la Ecua-

cién 3.62. Asimismo, el vector correspondiente a la presion sobre una cara especifica

¢ indicado como f'ie)(c) se obtiene de la Ecuacién 3.63. Este ultimo estd conformado

por subvectores fS)(c) en cada nudo ¢ ast:

o
(O

o |E

FOO |2 (3.88)
O

A diferencia del elemento hexaédrico, el elemento prisma puede tener caras con-
formadas por 3 y 4 nudos. Esto significa que para el calculo de las fuerzas equivalentes
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a la accion de una presién se debe tener en cuenta el nimero de nudos de la cara
cargada.

Si la cara cargada del prisma es un cuadrilatero, el subvector de fuerzas equiva-
lentes a la accién de la presion en los nudos que conforman la cara es:

0 _ A | ) i=1,2,3,4,56
sci A Dyc (389)
| o= (1254), (1463), (2365)
Pzc

Por ejemplo, si se considera una presién uniforme en coordenadas globales aplica-

da a la cara (1254), los coeficientes que corresponden a los nudos que no pertenecen
. ~(e)(1254)
a la cara cargada son iguales a cero. El vector f es

st

T

f(e)(1254) . A§62)54 [ (e) (e) () (e)
s 4

Pioss Pizsa O Pizsy Pioss 0]1
x18

donde
(e) _ _
Pigs4 = [ ;61)254 pg(fl)254 p,(zel)254:| ) 0= [O 0 O]

Cuando la cara cargada del prisma es triangular, el subvector de fuerzas equi-

valentes a la accién de la presién en coordenadas globales f «©

sci» Sobre los nudos que
conforman la cara es:

(e)

o a9 "0 ] [i=12,3.45.6
sei 3 Dyc (390)
1 o= (132), (456)
Pzc

Por ejemplo si la cara cargada es la (132), el vector fi?(lw) corresponde a:

F00132) _ Al%) [ (& () () !

s 3 Pis2 Pi32 Pi32 (OO O]

1x18

donde

(6) _ e e e .
Pis2 = [p;1)32 p?(,l)32 pil)?,z} ) 0= [O 0 0}
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3.7.10. Vector de fuerzas equivalentes a la accién de una presién unifor-
me normal a una cara del elemento

El vector normal unitario a una cara cuadrilateral del elemento prisma se define
siguiendo el procedimiento indicado en la Subseccion 3.6.11, que fue utilizado en
las caras de elementos hexaédricos. Asimismo, el vector normal unitario a una cara
triangular se obtiene de la misma manera que en elementos tetraédricos, como se
indica en algunas referencias (Linero et al.,, 2020). Este procedimiento se resume
en calcular el vector normal a la superficie mediante el producto cruz entre dos de
sus lados, utilizar un nudo externo para definir la direcciéon entrando al elemento y
normalizar el vector. Por ejemplo, la Figura 3.9(a) muestra el vector normal unitario
a la cara (456).

Si la cara cargada tiene 4 nudos, cada componente de fuerza en direccién normal
en el nudo es igual a: .

f ) = AL (3.91)

En cambio, si la cara cargada tiene 3 nudos, cada componente de fuerza en di-

reccién normal en el nudo es:

nt

r(e)(c 1
J = gpl2 AL (3.92)

Por ejemplo, si se aplica una presién normal pff() a la cara triangular (456), las

456)

~(e)(456) ~(e)(456) ~(e)(456)
) fn5 y fn6

fuerzas equivalentes en los nudos seran f, , , como se ilustra en

las figuras 3.9(b) y (c), respectivamente.
El vector que contiene las componentes de las de fuerzas equivalentes completo

%(6)(456) o5

S

@56 1 o) (o) e
f, 3 PraseAase [O o O nif))ﬁ nz(15)6 nz(m)GL 18

donde
(e) e e
Nys56 = [n5;4)56 ng(/4)56 77124)56} ’ 0= [O 0 O}

Las componentes del vector de fuerzas equivalentes a la accién de una presién
normal sobre una cara, obtenida en los nudos que la conforman, se pueden expresar
en el sistema coordenado global mediante la Ecuacién 3.70. En el ejemplo anterior
la 3.9(d) muestra las componentes de la fuerza equivalente en la cara (456).
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7(e)(456
(o) (456)

F(e)(456)

n4
4

Figura 3.9: Presién uniforme normal que entra a la cara 4-5-6 del prisma: (a)vector normal entrando a la cara, (b)
presién uniforme normal que entra a la cara, (¢) fuerzas equivalentes en direccién normal, y (d) componentes de las
fuerzas equivalentes en sistema coordenado global.

3.7.11. Vector de fuerzas equivalentes a la accién de una presién hidro-
estatica

El procedimiento para calcular la presion hidroestatica sobre las caras de los elemen-
tos prisma es el mismo que fue aplicado a los elementos hexaédricos en la Subsec-
cién 3.6.12. Esta presién es uniforme en la cara del elemento finito y es funcién de
la profundidad dada por la coordenada yge) del centroide de dicha cara.

Las fuerzas equivalentes a la acciéon de una presion normal producida por el agua,
se obtiene de la misma forma como se describié en la Subseccién 3.7.10.
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Capitulo 4

Implementaciéon del programa de compu-
tador

En este capitulo se muestra la implementacién del método de los elementos finitos
para la solucién de un problema mecéanico elastico lineal tridimensional, utilizando
el elemento hexaedro de 8 nudos y el prisma de 6 nudos.

La implementacion del método de los elementos finitos para los elementos tra-
tados en este trabajo final de maestria, tiene como punto de partida el progra-
ma PEFiCA 2.0 (Linero et al., 2020), realizado en lenguaje de alto nivel GNU-
OCTAVE(Eaton et al., 2017) y acompanado del pre y post proceso gréfico con el
programa GMSH(Geuzaine & Remacle, 2019).

A continuacién se muestra la estructura general del programa, asi como los pro-
cedimientos y las rutinas nuevas que se implementan en el programa PEFiCA 2.0,
junto con las modificaciones a las rutinas existentes, que amplian la capacidad y el
alcance del programa original.

4.1. Descripcion de la estructura general del programa desa-
rrollado a partir de PEFiCA 2.0

Tal como se menciond en la Subseccion 2.2.3, este trabajo utiliza la estructura princi-
pal y las rutinas del programa PEFiCA 2.0 para dar la solucién al problema elastico
tridimensional mediante el método de elementos finitos.

Todas las rutinas de PEFiCA 2.0 esta hecha en programacion estructurada, por
lo que no hay saltos arbitrarios en la secuencia de ejecucién (Molina, 2006). De la
misma manera, las rutinas programadas para la solucién del problema de la mecéanica
estructural mediante el método de los elementos finitos con elementos hexaedro y
prisma mantienen esos mismos lineamientos.
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Para dar solucién a un problema elastico tridimensional el proceso general del
programa desarrollado a partir de PEFiCA 2.0 (Linero et al., 2020) es el siguiente:

(a) Utilizando el entorno grafico del programa GMSH se define la geometria del sdli-
do, las propiedades de los materiales, los desplazamientos iniciales y las fuerzas
o presiones actuantes. También se especifican los parametros del enmallado y se
genera la malla tridimensional de elementos. Esta informacién se exporta a un
archivo con extension .msh.

(b) El archivo con extensién .msh es leido por PEFiCA 2.0 mediante la funcién
LEGMSH. Alli se extraen las tablas y pardametros que se utilizan para la solucién
del problema. Algunas de estas tablas son las siguientes:

Coordenadas de los nudos

Conectividades y categorias de los elementos

Caracteristicas de las categorias de los elementos

Desplazamientos conocidos

Fuerzas aplicadas en los nudos de la malla

e Fuerzas uniformes distribuidas o presiones aplicadas en las caras de los
elementos

También se extraen los siguientes valores escalares:

Numero de nudos

Numero de elementos

e Numero maximo de nudos por elemento
e Numero maximo de puntos de Gauss en un elemento

e Numero de categorias de elementos

(c) A partir de la tabla de desplazamientos conocidos de algunos nudos, se crea la
tabla de grados de libertad por nudo, el subvector de desplazamientos conocidos,
y obtener el nimero de grados de libertad por nudo y el nimero de grados de
libertad conocidos.

(d) Se define el tamafio de la matriz de rigidez de la malla. A continuacién se genera
un ciclo por el nimero de elementos, donde se calcula la matriz de rigidez del
elemento finito y se ensambla en la matriz de rigidez de la malla. La libreria de
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elementos finitos cuenta con el tetraedro de 4 nudos, el hexaedro de 8 nudos y
el prisma de 6 nudos. La implementacién de las matrices de rigidez para los dos
ultimos elementos se describen en la Seccion 4.5.

A partir de la matriz de rigidez de la malla ensamblada K, se generan las sub-
matrices Kqo, Kog, Kgo v Kpg, de acuerdo al ntimero de grados de libertad
asociados a los desplazamientos desconocidos del problema.

Se genera el vector de fuerzas equivalentes a las fuerzas de cuerpo en la malla
mediante un ciclo por elemento, en el cual se ensambla el vector de fuerzas equiva-
lentes a las fuerzas de cuerpo cada elemento de acuerdo a sus grados de libertad.
Estos ultimos se describen en la Subseccién 3.6.9 para el elemento hexaédrico y
en la Subseccion 3.7.8 para el prisma.

Se define el vector de fuerzas equivalentes a fuerzas de superficie en la malla
utilizando principalmente la tabla de fuerzas uniformes distribuidas aplicadas
en las caras de los elementos, la tabla de incidencias y las coordenadas de los
nudos. El calculo de las fuerzas equivalentes a las presiones se muestra en las sub
secciones 3.6.10, 3.6.11 y 3.6.12 para el caso del hexaedro, y en las sub secciones
3.7.9, 3.79 y 3.7.11 para el caso del prisma. Posteriormente ensamblar en el
vector de fuerzas equivalentes a las fuerzas de superficie de la malla.

Se establece el vector de fuerzas aplicadas directamente en los nudos de la malla,
utilizando la tabla fuerzas aplicadas en los nudos.

Se obtiene el vector de fuerzas totales equivalentes en los nudos de la malla a
partir de la suma de los vectores anteriores, como se muestra en la Ecuacion 3.6.

Se calcula el vector de los desplazamientos desconocidos en los nudos de la malla
mediante la Ecuacion 3.12 y a partir de la numeracién de los grados de libertad,
se construye una tabla de desplazamientos ordenados por nudo.

Se evaltia el vector de las reacciones en los nudos de la malla mediante la Ecua-
cién 3.12 y a partir de la numeracién de los grados de libertad, se construye una
tabla de reacciones ordenadas por nudo.

Se obtienen las deformaciones y los esfuerzos en los vértices de cada elemen-
to finito. Para ello se realiza un ciclo por elemento anidado con otro ciclo por
coordenada del vértice, donde se calcula lo siguiente:

e la matriz de operadores diferenciales actuando sobre funciones de forma del
elemento tal como se indica en la Subseccién 3.6.6 y en la Subseccién 3.7.6,
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e ¢l vector de desplazamientos nodales del elemento a partir del proceso de
extraccion como lo indica la Ecuacion 3.16,

e ¢l vector de las componentes de deformaciéon como se indica en Ecua-
cion 3.17,

e la matriz constitutiva del material de acuerdo con la Subseccion 3.6.7,
e ¢l vector de las componentes de esfuerzo como lo muestra la Ecuacion 3.19,

e las deformaciones principales, los esfuerzos principales y el esfuerzo equiva-
lente de Von Mises, tal como se muestra en la Seccion 3.3 y en la Seccion 3.4.

(m) Mediante la funciéon IMGMSH, generar el archivo de extensién .pos en formato
de postproceso de GMSH, el cual contiene la informacién de desplazamientos
nodales y las reacciones en los nudos. Asimismo, incluye los esfuerzos y las de-
formaciones para cada categoria y elemento finito.

(n) Para el andlisis de los resultados, se carga el archivo de postproceso en el entorno

grafico de GMSH.

En la Figura 4.1 se muestra un resumen de las etapas principales del procedi-
miento general del programa implementado a partir de la estructura de PEFiCA
2.0.

4.2. Alcance del programa implementado

En los ejemplos de aplicacion se discretizo el sélido con mallas estructuradas, confor-
madas por elementos finitos hexaédrico de 8 nudos, prisma de 6 nudos o tetraédrico
de 4 nudos. Tales mallas se obtuvieron utilizando las funciones propias del entorno de
preproceso de GMSH, descritas en el manual de usuario presentado en la Seccién 7.1.

Esta malla de elementos puede representar varios materiales en diferentes partes
del sélido. Asimismo, para determinadas geometrias, como por ejemplo las cilindricas,
el programa GMSH asigna automaticamente combinaciones de elementos hexaédricos
y prismas. El alcance de este trabajo incluye estas combinaciones, como también las
mallas en las que s6lo hay un tipo de elemento, bien sea tetraedro, hexaedro o prisma,
para uno o varios materiales.

En la etapa de andlisis, las rutinas originales de PEFiCA 2.0 y las modificaciones
generadas por este trabajo, tienen su capacidad limitada por: el tamano méximo
admisible de una matriz cuadrada en el lenguaje de GNU-Octave, el sistema ope-
rativo y las caracteristicas del computador. Por ejemplo, utilizando un computador
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‘ Inicio ’

Lectura del archivo de preproceso
(*.msh) con la funcién LEGMSH

Definicién de tabla de incidencias,
grados de libertad conocidos, sub-
vector de desplazamientos conocidos
¥
Célculo y ensamblaje de la matriz
de rigidez K. Ciclo por elemento
de acuerdo con la Subseccién 3.2.1

|

Calculo del vector de fuerzas del
sistema f segin Ecuacién 3.7

'

Calculo del vector de fuerzas
nodales segin Ecuacién 3.15:
f(ﬁn) = Kgoa, + Kpgag — f3
Y
Célculo del vector de despla-
zamientos nodales segun Ecua-
cién 3.12: a, = K+ (fo — Kapap)
¥
Calculo de deformaciones y es-
fuerzos en los elementos. Ciclo por
elemento segiin la Subseccién 3.2.4

}

/ Escritura del archivo de postproceso /

(*.pos) con la funcién IMGMSH

‘ Fin ’

Figura 4.1: Diagrama de flujo resumido de las etapas principales del procedimiento general del programa desarrollado
a partir de PEFiCA 2.0, para dar solucién a problemas eldsticos tridimensionales.
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con un procesador Intel Core I7-6700HQ y 12Gb de memoria RAM, y ejecutando
el programa con GNU-Octave 4.4.1 en un sistema operativo Windows 7, se pueden
analizar problemas con mallas hasta de 9500 nudos aproximadamente.

Cabe mencionar nuevamente que las rutinas desarrolladas en este trabajo son
compatibles con el programa MATLAB. En la simulacién de los ejemplos de aplica-
cién, ejecutando con MATLAB el programa desarrollado, se observé que el tiempo
de calculo es del orden de 5 veces menos que en GNU-Octave y que la capacidad es
aproximadamente la misma.

4.3. Construccion del archivo de datos de entrada mediante
el entorno grafico de GMSH

El entorno gréafico de preproceso del programa GMSH permite construir un archivo
de datos de entrada del problema, el cual incluye la geometria, las condiciones de
borde, las acciones impuestas y las propiedades mecénicas de la malla de elementos
finitos.

Inicialmente se definen las entidades geométricas del problema que determinan su
geometria. A continuacion se establecen las entidades fisicas que representan las ca-
racteristicas de los materiales, las cargas y los desplazamientos conocidos. Asimismo,
se designan los parametros de la malla. Finalmente, el programa GMSH genera una
malla conformada por nudos y elementos finitos segin los parametros seleccionados.

Esta malla de elementos la exporta GMSH a un archivo de texto con extension
.msh, el cual contiene la informacién de los materiales, las coordenadas de los nudos,
los tipos de elemento y las demas condiciones del problema.

El procedimiento para construir el archivo de datos de entrada de un problema,
utilizando el entorno grafico de GMSH se describe en el manual de usuario presentado
en la Secciéon 7.1.

4.4. Lectura del archivo de datos de entrada generado en el
preproceso

La rutina LEGMSH escrita en GNU-Octave en el programa PEFiCA 2.0 permite leer
e interpretar el archivo de datos de entrada, el cual fue generado durante el pre-
proceso con el programa GMSH (con extensién .msh). Asimismo, esta rutina genera
las tablas, las matrices y los vectores requeridos en el analisis. El programa aqui
desarrollado amplia el alcance de ésta rutina, permitiendo la solucién de problemas
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mecanicos tridimensionales con elementos finitos hexaédricos y prismas. A continua-
cién se describen los procedimientos adicionados a dicha rutina.
La instruccion que llama a esta funcién tiene la siguiente estructura:

[(nnud), (neley, (nnue), (ngau), (ndim), (ncat), (tipr), (ennu), (impr), ...
. Azyz), (ele), (cat), (uco), ( fun), (fdi), (sup), (nct)] = LEGMSH({adad));

El pardmetro de entrada de la funcién es (adad), el cual para este trabajo es el
archivo que contiene la informaciéon de la malla de elementos finitos.
Los parametros de salida de la funcién son:

nnud): nimero de nudos,

nele): nimero de elementos,
nnue): niumero maximo de nudos por elemento,
ngau): nimero maximo de puntos de Gauss en un elemento,

ndim): niumero de dimensiones del problema,

ncat): numero de categorias de los elementos,

tipr): codigo del tipo de problema,

impr): tipo de impresién de los resultados,

xyz): tabla de coordenadas de los nudos,

ele): tabla de categorfas y conectividades de los elementos,

cat): tabla de categorias de los elementos,

uco): tabla de desplazamientos conocidos,

(

(

(

(

(

(

(

e (ennu): tipo de evaluacién de esfuerzos o deformaciones,

(

(

(

(

(

(fun): tabla de fuerzas aplicadas en los nudos,
(

fdi): tabla de fuerzas uniformes distribuidas que se aplican en las caras de los
elementos,

(sup): tabla auxiliar de identificador de la superficie asociada al elemento finito,
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e (nct): tabla auxiliar para impresién de archivo de posproceso.

En este trabajo se modificaron algunas caracteristicas de la funcién LEGMSH pa-
ra incluir la compatibilidad con los elementos hexaédrico y prisma, las cuales se
describen a continuacion:

e Tipos de elementos finitos: el nimero de tipos de elementos reconocidos por este

4.5.

procedimiento y sus cédigos asociados se ampliaron, permitiendo identificar y
utilizar el elemento hexaédrico de ocho nudos y el prisma de seis nudos.

Creacién de categorias: los elementos finitos definidos en el archivo generado por
GMSH del problema se agrupaban en categorias de acuerdo solamente con el
material al cual estaban asociados. En este trabajo se amplié este criterio para
que se generen nuevas categorias, de acuerdo también al tipo de elemento ya sea
tetraedro, hexaedro o prisma, considerando ademas sus posibles combinaciones.

Lectura de condiciones de borde en superficies cuadrilaterales: considerando
que tanto el elemento hexaédrico como el elemento prisma pueden tener des-
plazamientos conocidos y presiones sobre sus caras cuadrilaterales, se incluyo
la opcion de interpretar este tipo de acciones.

Tabla auxiliar (nct): se creé para facilitar la ubicacién de los elementos por
categoria dentro de la matriz que almacena los resultados. La sintaxis de cada
fila de dicha tabla es la siguiente:

[(nelc), (nnue), (mine), (maxe)]

El pardmetro (nelc) es el nimero de elementos de la categoria a la que le co-
rresponde la fila, (nnue) es el nimero de nudos del elemento de la categoria
a la que le corresponde la fila, (mine) es la minima posicién del primer ele-
mento de la categorfa en la matriz ELE y (maxe) es la maxima posicién del
primer elemento de la categoria en la matriz ELE. El nimero filas de esta tabla
corresponde a la cantidad de categorias del problema.

Rutinas modificadas de PEFiCA 2.0 en la etapa de pro-
ceso

El programa PEFiCA 2.0 permite el andlisis de problemas mecanicos tridimensionales
con elementos tetraédricos. Sus funciones han sido presentadas en el Capitulo 9 de
la referencia (Linero et al., 2020).
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En este trabajo final de maestria se modificaron algunas funciones del programa
PEFiCA 2.0 y se crearon nuevas funciones, con el fin de implementar los elementos
finitos hexaédrico y prisma en la solucién del problema elastico tridimensional.

A continuacién se describen brevemente las funciones de PEFiCA 2.0 que fueron
ampliadas y se detallan los cambios realizados en cada una de ellas:

4.5.1. Funcion PEFICA

Este es el procedimiento principal del programa, en él cual se encuentra la estructura
general de la solucién al problema elastico lineal tridimensional. A continuacion se
muestran los cambios que se realizaron en €l con el objetivo de ampliar el alcance
del mismo para utilizar los elementos finitos hexaédrico y prisma:

e Uso de la funcién linsolve: luego de realizar la particién segin el nimero de
grados de libertad conocidos y desconocidos de la matriz de rigidez del sélido
K, la cual genera las submatrices Ko, Ko, Ko ¥ Kgg, y del vector de fuerzas
nodales f, el cual genera los vectores f, y fg, se requiere encontrar la solucién
al sistema de ecuaciones simultaneas que calcula el vector de desplazamientos
desconocidos a, = K.\ (f, — Kusas) indicado en la Ecuacién 3.12.

Para dar la solucién al sistema, se utilizé la funciéon propia linsolve del len-
guaje de GNU-OCTAVE (compatible con MATLAB), con el fin de reducir el
tiempo de ejecucion de la solucién del sistema de ecuaciones simultaneas. Dado
que la submatriz de rigidez K,, es simétrica, se seleccion6 la opciéon corres-
pondiente de acuerdo con la siguiente sintaxis:

opts.SYM = true;
UAA=linsolve (KAA,AUX,opts);

siendo AUX el vector resultante de (f, — K,gag). En la Tabla 5.4 se demuestra
que el tiempo de ejecucion se redujo notoriamente utilizando esta funcién.

e Implementacién del célculo de la matriz B®): en el célculo de las deformaciones
y esfuerzos en cada elemento, se agregd una instruccion de seleccion del tipo de
elemento finito, de tal forma que se incluya a los elementos hexaédrico y prisma,
con sus procedimientos asociados al cdlculo de la matriz B(®). Tal matriz de
obtiene en las funciones NELEME, JELEME y BELEME, las cuales se mostraran en
las secciones 4.6.2, 4.6.1 y 4.5.3, respectivamente.

e Instrucciones de llamada a la funciones LEGMSH y IMGMSH: se modificaron las
instrucciones de llamada a éstas funciones, de acuerdo con los cambios en sus
argumentos mostrados en las secciones 4.4 y 4.7.
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4.5.2. Funcion KELEME

Esta funcién calcula la matriz de rigidez de un elemento finito. La instruccién de
llamada de la funcion es:

[(mtx)] = KELEME((tipe), (zye), (cae));

en donde (mtx) corresponde a la matriz de rigidez del elemento, (tipe) es un esca-
lar que indica el tipo de problema, (xye) es una matriz que contiene las coordenadas
de los nudos del elemento, y (cae) corresponde a una matriz fila que contiene las
propiedades de la categoria del elemento (Linero et al., 2020).

La ampliacion a esta funcién consiste en crear las subfunciones correspondientes
al cédlculo de las matrices de rigidez para el elemento hexaedro KHEXAE, y para el
elemento prisma KPRISM, como se puede observar en la Figura 4.2.

Las instrucciones de llamada de las subfunciones KHEXAE y KPRISM, las cuales
tienen los mismos argumentos de entrada que la funcién KELEME, son:

[(mtx)] = KHEXAE((tipe), (zye), (cae));
[(mtx)] = KPRISM((tipe), (zye), (cae));

Estas sub funciones realizan el cdlculo de la matriz de rigidez del elemento he-
xaédrico y prisma aplicando el procedimiento descrito en la secciéon Subsecciéon 3.6.8
y Subseccion 3.7.7 respectivamente. La implementacion de éstos procedimientos se
describe a continuacion:

(a) Se obtiene la matriz constitutiva del material del elemento finito D utilizando
la funcién DELEME (Linero et al., 2020).

(b) Se definen las coordenadas naturales correspondientes a los puntos de Gauss del
elemento finito, asi como su valores de ponderacién mediante la funcién PBPGAU.

(c) Se inicializa la matriz de rigidez del elemento K'© con ceros, de tamafio 24 x 24
en la sub funcién KHEXAE y 18 x 18 en la sub funcion KPRISM.

(d) Para obtener la matriz de rigidez del elemento K@, se debe realiza el procedi-
miento descrito en la seccién Subseccion 3.6.8 para cada punto de Gauss y luego
sumar el aporte de cada matriz de rigidez asociada a cada punto de Gauss en la
matriz K®. Esto se hace dentro de un ciclo que va desde ¢ = 1 hasta el ndmero
de puntos de Gauss del elemento ng, siendo ng = 8 para el hexaedro y ng = 6
para el prisma, donde se realizan los siguientes pasos:
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Inicio funcién KELEME ’

Lectura de parametros:
(tipe), (xye), (cae)

l

NOQ (tipe) = 3017

SI

l (Tetraedro)

NQ/  (tipe) = 302? ST

(Hexaedro)

Llamar sub-
funcién KTETRA

(tipe) = 3037 SI Llamar sub-
(Prisma) funcién KHEXAE

Llamar sub-
funcién KPRISM

NO 4>{ Fin funcién ’

Figura 4.2: Diagrama de flujo de la funcién KELEME, la cual calcula las matrices de rigidez elementales. Los conectores
de color rojo muestran las nuevas etapas implementadas, relacionadas con el calculo de la matriz de rigidez del

elemento hexaédrico (tipe=302) y prisma (tipe=303).
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e Se extrae la coordenada natural (£,,1,, fty) ¥ €l pardmetro de ponderacién
wg del punto de Gauss g.

e Se calcula la matriz de operadores diferenciales con respecto al sistema na-

tural actuando sobre funciones de forma E(e), utilizando la funciéon NELEME,
evaluada en el punto de Gauss g.

e Con la matriz B(e) y la matriz de coordenadas de los nudos del elemento,
utilizando la funcién JELEME se calcula la matriz inversa del Jacobiano del
elemento J (’5 y su determinante det J(,), evaluados en el punto de Gauss g.

e Con la matriz inversa del Jacobiano J (_61 y la matriz B(e), utilizando la
funcién BELEME se define la matriz de operadores diferenciales actuando
sobre las funciones de forma B(®).

e Se evalua el diferencial de volumen dV mediante el producto entre el inverso
del Jacobiano J (_5 y el valor de ponderacién w, del punto de Gauss g.

e Se suma el aporte a la matriz de rigidez del elemento K© del punto g,
mediante K = K© + B"@DB® g1

(e) La funcién retorna la matriz resultante K© del elemento.

4.5.3. Funcién BELEME

Esta funcién se encarga del calculo de la matriz B. La instruccién que llama a la
funcién es de la forma:

[(bel)] = BELEME({xye), (zip), (tipe));

Los parametros de entrada de esta funcion, para elementos tetraédricos son: la
matriz que contiene las coordenadas de los nudos de un elemento (xye), la coordenada
del punto (xip) donde se evalia la funcién de forma dentro del elemento en sistema
coordenado natural, y el identificador del tipo de elemento finito (tipe).

La ampliacion de BELEME consiste en identificar el tipo de elemento y calcular la
matriz B(® de un elemento hexaédrico o prisma. Si el parametro (tipe) = 302 calcula
la matriz del elemento hexaédrico y si (tipe) = 303 obtiene la matriz de elemento
prisma. Lo anterior se puede ver en la Figura 4.3.

Por otro lado, los parametros de entrada para los elementos hexaédrico y prisma
se modificaron, conservando la misma forma de la instruccién de llamada. Para el
elemento hexaédrico y prisma, los parametros de entrada son:
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Inicio funcién BELEME ’

!

Lectura de
parametros:
(tipe). (oye). (oyp)
[(tipe), (ijc), (der)]

!

NOQ/  (tipe) = 3017 ST
l (Tetraedro)

Llamar sub-

NO (tipe) = 3027 SI funcién BTETRA
l (Hexaedro)
(tipr) = 3037 SI Llamar sub-
(Prisma) funcién BHEXAE

Llamar sub-
funcién BPRISM

NO — Fin funcién ’

Figura 4.3: Diagrama de flujo de la funcién BELEME, que calcula la matriz B(¢). Los conectores de color rojo muestran
las nuevas etapas implementadas, relacionadas con el célculo de la matriz B(¢) del elemento hexaédrico (tipr=302)
y prisma (tipr=303).
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[(bel))] = BELENE((ijc), (der), {tipe));
donde (ijc) es la matriz inversa del Jacobiano J ge), evaluada en el punto de Gauss
g dentro del elemento en coordenadas naturales, y (der) es la matriz de derivadas de

las funciones de forma B;e) evaluada en el mismo punto.

Dentro de la funciéon BELEME, se encuentra la funcién BHEXAE, que genera la matriz
B del hexaedro segun la Ecuacion 3.48c, y BPRISM, la cual crea la matriz B del
prisma segun la Ecuacién 3.85c¢.

4.5.3.1. Funcion FELEMC

Esta funcion calcula el vector de fuerzas equivalentes a la accion de fuerzas de cuerpo
en un elemento finito. La instruccion que llama a la funcion es:

[(fel)] = FELEMC((xye), (cae));

donde (fel) corresponde al vector de fuerzas equivalentes a la accién del peso pro-

pio del material sobre el elemento fl()e), (xye) es la matriz que contiene las coordenadas
de los nudos del elemento, y (cae) es una matriz fila que contiene las propiedades de
la categoria de un elemento.

En este trabajo se implemento el célculo del vector fl()e) para el elemento hexaédri-
co y el prisma, utilizando las sub funciones FHEXAC y FPRISM respectivamente, como
se ve en la Figura 4.4. La instruccién que llama a la subfuncién FHEXAC es similar a
la que se utiliza para FPRISM, y es de la forma:

[(fel)] = FHEXAC((nnue), (xye), (cae));

donde los pardmetros (fel), (xye) y (cae) son los mismos utilizados para la funcién
FELEMC, y se agrega el parametro (nnue), el cual indica el nimero de nudos del
elemento.

Dentro de cada de las subfunciones anteriores, se hace un llamado a la funcion
PBPGAU para traer las coordenadas naturales y los pardmetros de ponderacién de
los puntos de integracién, de acuerdo con el nimero de nudos del elemento (nnue).

Asimismo, se suma el aporte de cada uno de los puntos de Gauus al vector f'l(,e), tal
como se indica en la Ecuacién 3.61.
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Inicio funcién FELEMC

Lectura d

e parame-

tros: [(xye), (cae)]

NOQ/  (tipe) = 3017 ST
l (Tetraedro)

NO/  (tipe) = 3027
(Hexaedro)

(tipr) = 3037 ST
(Prisma)

Llamar sub-
SI funcion FTETRC

Llamar sub-
funciéon FHEXAC

funciéon FPRI

Llamar sub-

SM

NO 4% Fin funciéon ’

Figura 4.4: Diagrama de flujo de la funcién FELEMC, que calcula el vector fl§8>. Los conectores de color rojo muestran

las nuevas subfunciones implementadas, relacionadas con el célculo del vector féc) del elemento hexaédrico (tipr=302)

y prisma (tipr=303).
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4.5.4. Funcion FELEMS

Esta funcién calcula el vector de fuerzas equivalentes a la acciéon de las fuerzas de
superficie del elemento finito tridimensional. La instruccion que llama a la funcién
es:

[(fel)] = FELEMS((tipe), (zye), (zyc), (ela), (fde));

e (fel) corresponde al vector de fuerzas de superficie del elemento finito fie),

e (tipe) es el identificador del tipo de elemento,

xye) es la matriz que contiene las coordenadas de los nudos del elemento,

ela) es el identificador de los nudos del elemento.

fde) corresponde a las caracteristicas de la carga distribuida extraidas de la

(

(

(

e (xyc) son las coordenadas de los nudos de la cara cargada, y

(

(
tabla F'DI (Linero et al., 2020).

La tabla FF'DI se amplié para que permita llevar las caracteristicas de las caras
cargadas de cuatro nudos, por lo que (fde) es de la forma:

[(fde)] = ((iele), (nudi), (nudj), (nudk), (nudl), (prel), (pre2), (pre3), (gloc));
donde:
e (iele) es el indicador del elemento, y

o (nudi), (nudj), (nudk) y (nudl) son los identificadores de los nudos de la cara
cargada.

Las variables (prel), (pre2) y (pre3) dependen del tipo de presién que se aplique
en la cara del elemento, las cuales se indican mediante la variable (gloc) de la siguiente
manera:

e Si (gloc = 0), la presién que estd aplicada en la cara del elemento corresponde
a una presién uniforme en coordenadas globales, por lo que las variables (prel),
(pre2) y (pre3) corresponden a las componentes de ésta presion: pﬁ?, pé‘;j y p((;i),

respectivamente.
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e Si (gloc = 1), la presion en la cara es una presién uniforme normal a la cara,
cuyo valor pt se almacena en la variable (pre2). (prel) y (pre3) en este caso

no se utilizan y toman un valor igual a cero.

e Si (gloc = 2), la presién en la cara del elemento es una presion hidrostatica que
estd en funcion del peso especifico del agua v, y de su altura h,,, las cuales se
almacenan en los pardmetros (prel) y (pre2). El parametro (pre3) no varfa y
se fija como cero.

En este trabajo se implementd el cdlculo del vector de fuerzas equivalentes a las
fuerzas de superficie para el elemento hexaédrico a través de la subfuncion FHEXAS,
y para el prisma mediante la funcién FPRISS, como se muestra en la Figura 4.5. La
instruccion de llamada para la subfuncién FHEXAS es:

[(fel)] = HEXAS((zye), (xyc), (ela), (fde));

donde los pardmetros de entrada (zye), (xyc), (ela) y (fde), usados también en la
subfunciéon FPRISS son los mismos parametros utilizados para la funcién FELEMS.
Los procedimientos utilizados para el calculo del vector de las fuerzas equivalentes

f’ie) en las sub fubciones FHEXAS Y FPRISS dependen del valor de la variable (gloc),
asi:

e Si (gloc = 0), el procedimiento para el célculo del vector de fuerzas equiva-
lentes a la accién de una presién uniforme en sistema coordenado global para
una cara del hexaedro, utilizado por la sub funcién FHEXAS, corresponde a la
Subseccion 3.6.10. Si en cambio la presion se aplica en una cara de un elemento
prisma, mediante la sub funcién FPRISS, el procedimiento utilizado corresponde
al mostrado en la Subseccién 3.7.9.

e Si (gloc = 1), el procedimiento utilizado por la sub funcién FHEXAS para el
calculo del vector de fuerzas equivalentes a la acciéon de una presion uniforme
normal, para una cara del hexaedro corresponde a la Subseccién 3.6.11. Si en
cambio la presion se aplica en una cara de un elemento prisma, mediante la
sub funcién FPRISS, el procedimiento utilizado corresponde al mostrado en la
Subseccion 3.7.10.

e Si (gloc = 1), el procedimiento utilizado por la sub funcién FHEXAS para calcu-
lar el vector de fuerzas equivalentes a la accion de una presion hidroestatica,
para una cara del hexaedro corresponde a la Subseccién 3.6.12. Si en cam-
bio la presion se aplica en una cara de un elemento prisma, mediante la sub
funcién FPRISS, el procedimiento utilizado corresponde al mostrado en la Sub-
seccion 3.7.11.
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Inicio funciéon FELEMS

Lectura de parametros:
[(tipe), (zye), (xyc), (ela), (fde)]

NOQ/  (tipe) = 3017 ST
l (Tetraedro)
Llamar sub-
NO (tipe) = 3027 SI funcién FTETRS

(Hexaedro)

(tipr) = 3037 SI Llamar sub-
(Prisma) funcién FHEXAS

Llamar sub-
funcién FPRISS

NO 4% Fin funcién ’

Figura 4.5: Diagrama de flujo de la funcién FELEMS, que calcula el vector fs(e). Los conectores de color rojo muestran

las nuevas subfunciones implementadas en este trabajo, relacionadas con el cédlculo del vector fs(e) del elemento
hexaédrico (tipr=302) y prisma (tipr=303).
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4.5.5. Funcion PBNUEL

Esta funcién identifica el niimero de nudos de un elemento finito y de sus caras, y el
numero de puntos de Gauss recomendado a partir de su tipologia. La instruccién de
llamada de esta funcién es:

[(nuel), (nuca), (pgau)] = PBNUEL((tipe));
donde:
e (nuel) es el nimero de nudos del elemento,
e (nuca) corresponde al nimero de caras,
e (pgau) es el numero de puntos de Gauss recomendado y
e (tipe) es un escalar asociado al tipo de elemento.

Se modificé esta funcién para que el pardmetro de entrada (tipe) pueda tomar los
valores de (tipe) = 302 para el caso del elemento hexaedro de 8 nudos, y (tipe) = 303
para el caso del prisma de 6 nudos, como se muestra en la Figura 4.6.

De esta manera, la funcién devuelve los siguientes parametros, segtin el valor de

(tipe):
e Si (tipe) = 301, (nuel) =4, (nuca) = 3y (pgau) = 1.
e Si (tipe) = 302, (nuel) = 8, (nuca) =4y (pgau) = 8.

o Si (tipe) = 303, (nuel)

6, (nuca) =4y (pgau) = 6.

4.5.6. Funcion PBPGAU

Esta funcién devuelve los pardametros de ponderacién y ubicacion de los puntos en
coordenadas naturales determinados por el método de integracién numérica de la
cuadratura de Gauss. La instruccion de llamada de la funcion es:

[(mtx)] = PBPGAU((ngau), (ndim), (ennu));

en donde el pardmetro de salida (mtx) es una tabla con la ubicacién de los puntos
de ponderacién y sus respectivas constantes de ponderacion. El pardmetro de entrada
(ngau) corresponde al nimero de puntos de Gauss, el cual se asocia ademds con el
tipo de elemento finito. El pardmetro (ndim) corresponde al niimero de dimensiones
del problema.
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Inicio funcién PBNUEL ’

Lectura de parame-
tros: (tipe)

Y
NO/" (tipe) = 301? SI
l (Tetraedro)
Asignar
(nuel) = 4
NO/  (tipe) = 3027 ST (nuca) = 3
(Hexaedro) (pgau) =1

Asignar
(tipe) = 3037 ST (nuel) = 8
(Prisma) (nuca) = 4
(pgau) = 8

NO — Fin funcion |

Figura 4.6: Diagrama de flujo de la funcién PBNUEL, que devuelve el nimero de nudos de un elemento finito (nuel)
y de sus caras (nuca), y el nimero de puntos de Gauss (pgau). Los conectores de color rojo muestran las nuevas
subfunciones implementadas en este trabajo, relacionadas con el elemento hexaédrico y prisma.
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Para el caso especifico del elemento hexaédrico, las coordenadas de los puntos
de Gauss y las ponderaciones que devuelve la funcién son los mostrados en la Ta-
bla 3.2(b). Asimismo, las coordenadas naturales de los nudos son los mostrados en
la Tabla 3.1.

Para el caso del elemento prisma, los puntos de Gauss son los mostrados en la
tabla Tabla 3.4, y las coordenadas naturales de los nudos son las mostradas en la
Tabla 3.3.

En general, la funciéon PBPGAU permite extraer la ubicacién de diferentes puntos
en el interior del elemento, de acuerdo con el parametro (ennu), asi:

e Si(ennu) = 0, la funcién devuelve en la matriz (mtz) las coordenadas naturales
de los puntos de Gauss y sus ponderaciones.

e Si (ennu) = 1, la funcién devuelve en la matriz (mtz) los nudos del elemento
en coordenadas naturales.

e Si (ennu) = 2, la funcién devuelve en la matriz (mtz) las coordenadas del
centro del elemento, en coordenadas naturales.

4.6. Rutinas nuevas en la etapa de proceso

En esta seccion se describen las rutinas nuevas que se implementaron en el desarrollo
de este trabajo. Particularmente, dichas funciones se utilizan en el calculo de la
matriz Jacobiana y de la matriz de funciones de forma de los elementos.

4.6.1. Funciéon JELEME

Esta funcién calcula la matriz Jacobiana, su inversa y su determinante para los
elementos tridimensionales. La instrucciéon que llama a esta funcién tiene la forma:

[{gac), (ije), (detj)] = JELEME((zye), (der), (tipe));

A su vez este procedimiento contiene las funciones JHEXAE y JPRISM, las cuales
calculan la matriz Jacobiana, su inversa y su determinante para el elemento he-
xaédrico y prisma, respectivamente. Para calcular la matriz Jacobiana del elemento
hexaédrico y prisma, se utiliza la Ecuacion 3.36.

Con la matriz Jacobiana de tamano 3 x 3, su inversa y su determinante se cal-
culan utilizando las funciones que trae incorporadas el lenguaje de GNU-OCTAVE
(compatibles con MATLAB). Estas instrucciones son inv(JAC) para el calculo de la
inversa y det (JAC) para el calculo del determinante.
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4.6.2. Funcion NELEME

Esta funcién puede calcular la matriz de funciones de forma y las derivadas estas
ultimas con respecto a las coordenadas naturales en los elementos tridimensionales.
La instruccion que llama a esta funcién tiene la forma:

[(nel)] = NELEME((tipe), (tare), (xi), {eta), (mu));

donde el pardmetro de salida (nel) puede ser: la matriz de las funciones de forma
o la matriz de las derivadas de las funciones de forma con respecto a las coorde-
nadas naturales, dependiendo del pardmetro de entrada (tare) y del pardmetro de
identificacién del elemento (tipe), de la siguiente manera:

e Si (tare) = 1y (tipe) = 302, la funcién devuelve la matriz de las funciones
de forma para el elemento hexaédrico, evaluada en el punto de coordenadas
naturales (£, 7, ), de acuerdo con la Ecuacién 3.28c.

e Si (tare) = 2y (tipe) = 302, la funcién retorna la matriz de las derivadas de las
funciones de forma con respecto a las coordenadas naturales para el elemento
hexaédrico, evaluada en el punto (&, 7, 1), como se muestra en la Ecuacién 3.38.

e Si (tare) =1y (tipe) = 303, la funcién devuelve la matriz de las funciones de
forma para el elemento prisma, evaluada en el punto de coordenadas naturales
(&,1m, 1), de acuerdo a la Ecuacion 3.77.

o Si(tare) = 2y (tipe) = 303, la funcién retorna la matriz de las derivadas de las
funciones de forma con respecto a las coordenadas naturales, evaluadas en el
punto (&, 7, 1) para el elemento prisma, como se muestra en la Ecuacién 3.82.

Las coordenadas naturales &, n y p corresponden a los pardmetros de entrada
(xi), (eta) y (mu), respectivamente.

4.7. Creacion del archivo de postproceso

La funcién IMGMSH en el programa PEFiCA 2.0 (Linero et al., 2020), genera el archivo
de postproceso, el cual contiene los resultados del problema elastico tridimensional
analizado. Esta funcién crea los archivos con extension .pos y .pos.opt, en el for-
mato adecuado para que puedan ser leidos y mostrados a través del entorno grafico
de post proceso del programa GMSH.

En este trabajo se amplié la funcién IMGMSH para generar las tablas correspon-
dientes a los desplazamientos, fuerzas, esfuerzos y deformaciones en los nudos de
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elementos hexaédricos y prismas, en un archivo de salida para su posterior visua-
lizacién en GMSH. Asimismo, se modificé esta rutina considerando adicionalmente
las diferentes categorias de tipo de elemento finito. La instrucciéon para ejecutar esta
funcion es de la forma:

IMGSH({(adad), (nnud), (nele), (nnue), (ngau), (ncat), (xyz), . ..
... (ele), (sup), (uxy), (fzy), (sre), (ere), (pro), {cat), (nct));

Los parametros de entrada de la funcién IMGSH son:

e (adad) es el nombre del archivo de datos sin extension,
(

nnud) es el nimero de nudos,

e (nele) es el numero de elementos,

e (nnue) es el nimero de nudos méximo de un elemento,

e (ngau) es el nimero maximo de puntos de Gauss de un elemento,

e (ncat) es el nimero de categorias,

e (zyz) es la tabla de coordenadas de los nudos,

e (ele) es la tabla de conectividades de los elementos,

e (sup) es la tabla de identificacién de superficies asociada al elemento,

e (uzy) es la tabla de desplazamientos en los nudos,

e (fxy) es la tabla de fuerzas en los nudos,

e (sre) es la tabla de esfuerzos en los elementos,

e (ere) es la tabla de deformaciones en los elementos,

e (pro) es el numero indicador para la escritura de los esfuerzos y deformaciones
promedio en los nudos o en el interior de los elementos

e (cat) es la tabla de categorias de los elementos,

e (nct) es la tabla auxiliar para impresién de archivo de posproceso.
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La funcion IMGMSH utiliza otras sub funciones vinculadas al posprocesamiento
de la soluciéon del problema. La sub funcién que fue modificada en este trabajo es
ORSOCA. Esta funcion crea la tabla del promedio de un resultado sobre los nudos a
partir de la misma cantidad obtenida en los extremos de los elementos que pertenecen
a la misma categoria. La instruccién de llamada de la funcion tiene la forma:

[(nud), (nuca)] = ORSOCA({ele), (rel), (nnud), (ncom), (icat), (nct), (ncat));
donde los parametros de salida de la funcién son:
e (nud) es la tabla de resultados promedio de la cantidad en los nudos, y
e (nuca) es el numero de nudos de la categoria.
En cambio, los parametros de entrada de la funcién son los siguientes:
e (ele) es la tabla de categorias y conectividades de los elementos,

rel) es la tabla con los esfuerzos o deformaciones en los nudos de cada elemento,

nnud) es el nimero de nudos del elemento,

icat) es el indicador de la categoria de los elementos,

ncat) es el nimero de categorias y

(
(
(
e (ncom) es el nimero de componentes de los resultados,
(
(
(

nct) es una tabla auxiliar para impresion del archivo de postproceso, cuyo
numero de filas corresponde a la cantidad de categorias del problema. La sin-
taxis de cada fila de esta tabla es de la forma:

[(nelc), (nnue), (mine), (maxe)]

El pardmetro (nelc) es el nimero de elementos de la categoria, (nnue) es el
nimero de nudos del elemento de la categoria, (mine) es la minima posicién
del primer elemento de la categoria en la matriz ELE y (maze) es la méxima
posicién del primer elemento de a categoria en la matriz ELE.

Esta funcién se modificé utilizando los nuevos pardmetros (ncat) y (nct), para
lograr extraer el contenido de la tabla de resultados (rel) de acuerdo a la categoria
(icat).
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Capitulo 5

Ejemplos de aplicacién y analisis de resul-
tados

En este capitulo se muestran algunos problemas tridimensionales de solidos que fue-
ron resueltos utilizando el programa presentado. Para cada uno de éstos problemas
se muestra ademas:

e Un archivo que contiene la geometria, los desplazamientos conocidos, las accio-
nes aplicadas y los parametros de construccion de malla en formato de prepro-
ceso de GMSH, con extension .geo.

e Un archivo que contiene la malla de elementos finitos utilizada, con extensién
.msh.

e Dos archivos de resultados en el formato de postproceso de GMSH, con exten-
siones .pos y .pos.opt.

El objetivo en este capitulo es realizar una comparacion entre las soluciones ob-
tenidas mediante el método de los elementos finitos con las siguientes caracteristicas:

e Andlisis realizado con el programa desarrollado en este trabajo final, cons-

truyendo mallas de elementos hexaédricos de 8 nudos, utilizando el programa
GMSH.

e Analisis realizado con el programa PEFICA 2.0, construyendo mallas de ele-
mentos tetraédricos de 4 nudos, utilizando el programa GMSH.

e Anélisis realizado con el programa comercial ANSYS, construyendo mallas de
elementos hexaédricos de 8 nudos con integracién simplificada (SOLID185).
Esta simulacion es utilizada como verificacién.
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Figura 5.1: Geometria de la presa sometida a la presién hidrdulica y su peso propio: (a) seccién transversal y (b)
vista de planta. Unidades en metros.

5.1. Ejemplo 1: Presa de béveda sometida a la presion hidrauli-
ca y su peso propio

Este ejemplo de aplicacion estd basado en el presentado en el capitulo 9 de la refe-
rencia (Linero et al., 2020). Esta estructura tiene una geometria similar a la presa
Hoover en Estados Unidos y estd sometida a la presion hidraulica y a su propio peso.
Se encuentra empotrada en la roca en sus lados y en su base, en donde se asume que
las componentes de desplazamiento son nulas, es decir, u =0, v =0y w = 0.

El agua tiene una altura h, = 180.0m y un peso especifico 7, = 9.8 kN/m?,
como se ilustra en la Figura 5.1(a). La presa es de concreto con peso especifico
v = 24kN/m?, médulo de Young E = 45.6kN/m? y relacién de Poisson v = 0.21.

El problema es simétrico con respecto al eje # mostrado en la Figura 5.1(b),
razon por la cual se simula solamente la mitad de la presa. En su plano de simetria,
la componente de desplazamiento en direccién z es igual a cero, es decir w = 0.
Mientras que en el plano del costado opuesto, correspondiente al apoyo lateral en la
roca, las componentes x, y y z del desplazamiento son iguales a cero, es decir u = 0,
v=0yw=0.

5.1.1. Creacién de las mallas de elementos finitos

Para la creacion de la malla utilizando elementos hexaédricos mediante GMSH, se
define la seccién transversal como un plano compuesto por superficies cuadrilaterales,
a partir de las cuales se genera su volumen por rotacién. Lo anterior permite generar
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una malla estructurada con elementos hexaédricos.

Y

le_x

Figura 5.3: Volumen completo de la presa compuesto
por volimenes asociados a superficies cuadrilatera-
les, realizada en el programa GMSH.

Figura 5.2: Seccién transversal dividida en cua-
driléteros realizada en el programa GMSH .

En la Figura 5.2 se muestra la divisién de la seccion transversal en cuadrildte-
ros y en la Figura 5.3 se presenta el volumen compuesto generado en GMSH. La
informacion detallada de la creacién de la malla se presenta en la Seccion 7.1.

Considerando las condiciones iniciales del problema, se asignan las propiedades
de los materiales, se introducen los parametros para generar la malla estructurada
en cada linea, se indican los planos con desplazamientos restringidos y también se
aplica la presion de agua siguiendo el procedimiento descrito en la Seccion 7.1.

En la primera simulacién se generé una malla de elementos finitos hexaédricos
presentada en la Figura 5.4 y en la Figura 5.5. Se realiz6 el enmallado con 8862
nudos, y 7580 hexaedros. La segunda simulacién tiene una malla de 45480 elementos
finitos tetraédricos y 8864 nudos. Esta iltima se presenta en la Figura 5.6 y en la
Figura 5.7.

Cabe resaltar que aunque el nimero de nudos en las dos mallas es casi el mismo,
la cantidad de tetraedros del segundo modelo es 6 veces el nimero de hexaedros de
la primera. Esto se debe a que para conformar un volumen hexaédrico, el generador
de malla de GMSH construye 6 elementos tetraédricos.

Con las mallas de hexaedros y tetraedros, se generan los archivos .msh corres-
pondientes, mediante el procedimiento descrito en la Secciéon 7.1.
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Figura 5.5: Malla de elementos finitos hexaédricos
en el programa GMSH. Los colores ilustran los sub
volimenes asociados a la extrusién de las superficies
cuadrilaterales.

Figura 5.4: Malla de elementos finitos hexaédricos
en el programa GMSH. Los colores ilustran los sub
volimenes asociados a la extrusién de las superficies
cuadrilaterales.

Y

L%

Figura 5.7: Malla de elementos finitos teraédricos en
el programa GMSH. El elemento tetraédrico no re-

Figura 5.6: Malla de elementos finitos teraédricos en h P . .
quiere sub volimenes para su implementacion.

el programa GMSH. El elemento tetraédrico no re-
quiere sub volimenes para su implementacién
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5.1.2. Solucién del problema utilizando el programa desarrollado

Luego de obtener los archivos de preproceso con extensiéon .msh que contiene cada
una de las mallas de elementos creadas con las condiciones del problema, se ejecu-
ta el programa desarrollado mediante la instruccion PEFICA hooverH 10, desde el
directorio activo \PEFTRI en el entorno de GNU- OCTAVE. El programa analiza
el problema y produce los archivos con extensiéon .pos y .pos.opt con los resulta-
dos, para que puedan ser leidos por el entorno grafico de post proceso del programa
GMSH. Este procedimiento se explica en detalle en la Seccion 7.2. Particularmente,
el procedimiento de calculo realizado por el programa desarrollado, para problemas

mecanicos tridimensionales con elementos tretraédricos, es el mismo implementado
en el programa PEFiCA 2.0.

5.1.3. Resultados

A partir de los archivos de los resultados creados por el programa desarrollado,
desde el modulo de post procesamiento del programa GMSH se leen los archivos con
extension .pos.

La configuracion deformada de la mitad de la presa bajo la acciones indicadas
anteriormente y la norma del vector desplazamiento en los nudos se ilustran en la
Figura 5.8 para la simulaciéon con elementos hexaédricos y en la Figura 5.9 para la
simulacion con elementos tetraédricos.
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Figura 5.8: Configuracién deformada y norma del Figura 5.9: Configuracién deformada y norma del
vector de desplazamiento en metros de la simulacién vector de desplazamiento en metros de la simulacién
realizada con hexaedros. realizada con tetraedros.

La distribucion del esfuerzo principal menor o3 para la simulacién con elemen-
tos hexaédricos se muestra en la Figura 5.10 y para la simulaciéon con elementos
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tetraédricos se muestra en la Figura 5.11.
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Figura 5.10: Distribucién de esfuerzo principal menor

o3 medido en kN/m? de la simulacién realizada con
hexaedros.

Figura 5.11: Distribucién de esfuerzo principal menor

o3 medido en kN/m? de la simulacién realizada con
tetraedros.

También se realizo la simulacion del problema en el programa ANSYS, en donde

se utiliz6 una malla con 8862 nudos y 7580 elementos hexaédricos como se muestra
en la Figura 5.12 y en la figura Figura 5.13.

ANSYS
ELEMENTS

ANSYS
2058 ELEMENTS 201982
AUG 11 2020

AUG 11 2020
19:59:21 20:02:33
T

Figura 5.12: Malla de elementos finitos hexaédricos

Figura 5.13: Malla de elementos finitos hexaédricos
de tipo SOLID185 en el programa ANSYS

de tipo SOLID185 en el programa ANSYS

En la simulacién realizada en el programa ANSYS se utilizé el elemento ”SO-
LID185” (Kohnke, 2009), con la opcién ”Simple enhaced strain”. Esta opcién de
integracién introduce selectivamente 9 grados de libertad internos adicionales en al-
gunos elementos para evitar el error generado por el bloqueo por cortante. Este error
hace que el elemento parezca mas rigido y produce desplazamientos menores de lo

© Alejandro Robayo Zapata



Capitulo 5. Ejemplos de aplicacién y andlisis de resultados 79

que deberian ser. Esta técnica se puede consultar en los trabajos de Simo y Rifai
(Simo & Rifai, 1990). Los resultados de esta simulacién se toman como referencia.

Los desplazamientos en los nudos de la simulaciéon realizado en el programa
ANSYS se muestran en la Figura 5.14. Asimismo, la distribucion del esfuerzo prin-
cipal menor o3 para esta simulacion se muestra en la Figura 5.15.

ANSYS| ANSYS
NODAL SOLUTION 20192 NODAL SOLUTION 201982

STEP=1 AUG 11 2020 STEP=1 AUG 11 2020
SUB =1 23:24:59 SUB =1 23:25:34
TIME=1
USUM

RSYS=0
DMX =.011211
SMX =.011211

(ave)

] 001246 .002491 003737 .004983 006228 .007474 008719 .009965 011211 -4234.58 _3638.34 -3042.1 2445.86 -1849.62 .1253.38 -657.135 _60.8947 535.346 13159
Figura 5.14: Configuracién deformada y norma del Figura 5.15: Distribucién de esfuerzo principal menor
vector de desplazamiento en metros de la simulacién o3 medido en kN/ m? de la simulacién realizada en
realizada en ANSYS ANSYS.

5.1.4. Analisis de resultados

A partir de la solucién del problema mecanico realizada con elementos hexaédricos
y tetraédricos utilizando el programa desarrollado en este trabajo final de maestria,
y a la simulacién realizada en el programa ANSYS, en la Tabla 5.1 se comparan
los resultados en un mismo punto de la norma del vector de desplazamiento y del
esfuerzo principal menor o3.

El valor maximo de la norma del vector de desplazamiento en los nudos que se
utiliza como comparacion, ocurre en todos los casos en la esquina superior de la cara
no restringida de la presa, como se puede observar en la Figura 5.8, la Figura 5.9 y
en la Figura 5.14.

El valor del esfuerzo principal menor que se compara en los tres casos ocurre en
la cara no restringida de la base de la presa, indicada como A en la Figura 5.15. Se
tomaron los valores de esfuerzo principal menor en el nudo ubicado en A para las
tres simulaciones. Estas distribuciones de esfuerzos se observan en la Figura 5.10, la
Figura 5.11 y en la Figura 5.15.

En la zona alrededor del punto B indicado en la Figura 5.15, el esfuerzo principal
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menor presenta valores cercanos a los indicados en el punto A. Por tal razon este
resultado no se comparé.

Tabla 5.1: Comparacién de resultados

Programa Elemento [[u]|™** (m) 4% (kN/m?) o (kN/m?)
De este trabajo hexaedro de 8 nudos 0.0116 —4679 6134
PEFiCA 2.0 tetraedro de 4 nudos 0.0110 —4 087 5010
ANSYS hexaedro de 8 nudos con enrique- 0.0112 —4071 5897
cimiento de la deformacién (SO-
LID185)

En la Tabla 5.1 se observa que la norma del vector de desplazamiento obtenida
en la simulaciéon con elementos hexaédricos en el programa desarrollado difiere un
5.2 % con respecto a la simulacién con la malla de elementos tetraédricos y un 3.4 %
en relacion con el programa ANSYS.

La pequena diferencia entre los valores de la norma del desplazamiento entre la
malla de elementos hexaédricos y de elementos tetraédricos se debe a la mayor rigidez
que ofrece un volumen conformado por este 1ltimo tipo de elemento, cuya funcién
es de un orden menor al del elemento hexaédrico. Asimismo, el resultado obtenido
con el programa desarrollado es similar al calculado en ANSYS.

También se observa que el esfuerzo principal menor o3 en el punto A de la si-
mulacién con elementos hexaédricos en el programa desarrollado, difiere un 12.7 %
con respecto a la simulacién con la malla de elementos tetraédricos y un 13.0% en
relacién con el programa ANSYS.

Adicionalmente se observa que el esfuerzo principal mayor o; con elementos he-
xaédricos en el programa desarrollado, difiere un 18.3 % con respecto a la simulacién
con la malla de elementos tetraédricos y un 3.9 % en relacién con el programa ANSYS.

La diferencia moderada entre los valores de esfuerzo principal menor y esfuerzo
principal mayor comparados, puede estar asociada a la aproximaciéon de la deforma-

cién en PEFICA 2.0 y ANSYS.

5.1.5. Anadlisis de sensibilidad

Se realizdé un andlisis de sensibilidad de la densidad de la malla con elementos he-
xaédricos, simulando el mismo problema con 7 mallas de diferente cantidad de ele-
mentos. En la Figura 5.16 se relaciona el valor maximo absoluto de la norma del
desplazamiento y del esfuerzo principal menor sobre los nudos de la malla, en funcién
de la cantidad de elementos finitos ne. Alli se observa que las magnitudes represen-
tativas son asintoticas a un valor en la medida en que la malla tiene mayor nimero
de elementos.
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Figura 5.16: Valores maximos absolutos en la malla en funcién del nimero de elementos finitos de 7 mallas de
elementos hexaédricos, correspondientes a: (a) la norma del desplazamiento de la malla (mm) y (b) el esfuerzo
principal menor( kN/m?).

5.2. Ejemplo 2: Ensayo de resistencia al arrancamiento del

concreto

A continuacién se simula un ensayo para determinar la resistencia a la compresion del
concreto, mediante la evaluacion de la fuerza necesaria para desprender la cabeza de
una barra de acero embebida en su interior. Este ensayo se encuentra estandarizado
en la norma ASTM C-900 (ASTM €900, 2007) y ha sido simulado previamente con
el programa PEFiCA 2.0 utilizando elementos tetraédricos (Linero et al., 2020).

Este ensayo consiste en el arrancamiento de una barra acero de 10mm de didmetro
y un cabezal de acero de 30mm de didmetro, embebidos en una regién de concreto
cilindrica de 60mm de altura y 120mm de didmetro. Se aplica una carga puntual P
en el extremo de la barra de acero. El concreto se apoya en un anillo circular. El
concreto y el acero solamente estan en contacto en la cara superior del cabezal, como
se muestra en la Figura 5.17.

Debido a sus simetrias, el dominio del problema se puede simplificar a una cuarta
parte, donde la componente del desplazamiento en direccién z es igual a cero en el
plano de simetria xy y la componente de desplazamiento x es cero en el plano de
simetria yz.

El acero tiene un médulo de elasticidad E, = 200 GPa, una relacién de Poisson
de v, = 0.20 y un esfuerzo de fluencia o,, = 250 MPa.

El concreto tiene un médulo de Young E. = 20 GPa, una relaciéon de Poisson
v, = 0.25 y resistencia a la compresion o, = 26.3 MPa.

En las simulaciones se aplica una presién uniforme en el cara superior de la barra
w, = P/A, asumiendo un valor de P = 1N. Como el area transversal de la barra de
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10mm de radio es A = 78.54mm?, la carga w, = 12.72 x 1073 N/ mm?.

Concreto

1

Apoyo PT"—30—IiIT15W

—

Barra —

x Cabezal

6T 08

u = 0 sim

Figura 5.17: Geometria del ensayo resistencia al arrancamiento del concreto. (a)Plano xz y (b)Plano xy. Unidades en
milimetros.

Y

lo_x
Figura 5.18: Seccién transversal dividida en cua- Figura 5.19: V’olumen del 'domlnlo modela,.do conf01T-
R ‘ mado por volimenes asociados a superficies cuadri-
drilateros, creada en el entorno grafico del programa ,
GMSH. laterales, generado desde el entorno gréfico del pro-

grama GMSH.
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5.2.1. Creacién de las mallas de elementos finitos

Para la solucién a este problema mecéanico se realizaron tres simulaciones distintas:
utilizando el programa desarrollado con elementos hexaédricos de 8 nudos, utilizando
el programa desarrollado con elementos tretraédricos de 4 nudos, y utilizando el
programa ANSYS con elementos hexaédricos con deformacion enriquecida.

Para la primera simulacion, se construye la seccion transversal a partir de super-
ficies cuadrilaterales, y luego se genera su volumen a partir de la extrusién de dicha
seccién. Se utiliza una malla estructurada con elementos hexaédricos.

En la Figura 5.18 se muestra la division de la seccion transversal en cuadriléte-
ros y en la Figura 5.19 se presenta el volumen compuesto generado en GMSH. La
informacion detallada de la creacién de la malla se presenta en la Seccion 7.1.

Después de construidas las entidades geométricas, se asignan a las superficies y
volimenes los desplazamientos restringidos en el concreto, la presion aplicada a la
barra y las propiedades mecanicas de los materiales. A continuacion se introducen
los parametros para generar la malla estructurada. Este procedimiento esta detallado
en la Secciéon 7.1.

La malla de elementos finitos hexaédricos se presenta en la Figura 5.20 y en la
Figura 5.21. Se realiz6 el enmallado con 7524 nudos, 416 prismas y 5980 hexaedros.

Esta malla utiliza prismas en la zona cercana al eje del cilindro, para completar el
volumen.
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Figura 5.20: Malla de elementos finitos hexaédricos Figura 5.21: Malla de elementos finitos hexaédricos
en el programa GMSH. Los colores ilustran los sub en el programa GMSH. Los colores ilustran los sub
volimenes asociados a la extrusién de las superficies volimenes asociados a la extrusién de las superficies

cuadrilaterales. cuadrilaterales.

En la segunda simulaciéon se construyé una malla de 37128 elementos finitos
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tetraédricos y 7524 nudos, la cual se presenta en la Figura 5.22 y en la Figura 5.23.
Al igual que en el ejemplo anterior, se mantuvo el nimero de nudos en la malla de
hexaedros, igual al de la malla de tetraedros.
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Figura 5.22: Malla de elementos finitos tetraédricos Figura 5.23: Malla de elementos finitos tetraédricos
en el programa GMSH. en el programa GMSH.

Con las mallas de hexaedros y tetraedros, se generan los archivos .msh corres-
pondientes, mediante el procedimiento descrito en la Seccién 7.1.

5.2.2. Solucion del problema

Con los archivos de preproceso con extension .msh que contienen la malla de elemen-
tos y las condiciones del problema, se ejecuta la instruccién PEFICA PullOutH 12,
desde el directorio activo \PEFTRI en el entorno de GNU- OCTAVE. El programa
analiza y produce los archivos con extensiéon .pos y .pos.opt con los resultados,
para ser leidos por el programa GMSH.

5.2.3. Resultados

A partir de los archivos de los resultados creados por el programa desarrollado,
desde el modulo de post procesamiento del programa GMSH se leen los archivos con
extension .pos.

La configuracion deformada de la simulacién bajo las acciones indicadas anterior-
mente y la norma del vector desplazamiento en los nudos se ilustran en la Figura 5.24
para la simulacién con elementos hexaédricos y en la Figura 5.25 para la simulacion
con elementos tetraédricos.
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Desplazamientos nodales Y Desplazamientos nodales Y
2 04e-008 2.16e-006 4.31e-006 Q? 8.47e-009 2 04e-006 4.08e-006 ké
L © | e
Figura 5.24: Configuracién deformada y norma del Figura 5.25: Configuracién deformada y norma del
vector de desplazamiento en metros de la simulacién vector de desplazamiento en metros de la simulacién
realizada con hexaedros. realizada con tetraedros.

La distribucién del esfuerzo principal menor o3 para la simulacién con elemen-
tos hexaédricos se muestra en la Figura 5.26 y para la simulaciéon con elementos
tetraédricos se muestra en la Figura 5.27.

Esfuerzo prom. categ. 1 SP3 Y Esfuerzo prom. categ. 1 SP3 Y
-0.00333 -0.00146 0.000403 Q? -0.00248 -0.00117 0.000136 ké
[ © . | e
Figura 5.26: Distribucién de esfuerzo principal menor Figura 5.27: Distribucién de esfuerzo principal menor
o3 en el concreto, medido en kN/m? de la simulacién o3 en el concreto, medido en kN/m? de la simulacién
realizada con hexaedros. realizada con tetraedros.
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La distribucion del esfuerzo de Von Mises o, en el acero para la simulacién
con elementos hexaédricos se muestra en la Figura 5.28 y para la simulacién con
elementos teraédricos se muestra en la Figura 5.29.

Esfuerzo prom. categ. 2 SVM Y Esfuerzo prom. categ. 2 SVM Y
0.00124 0.00974 00182 LJ\ 0.00142 0.00901 0.0166 ;J\X
[ ] x [ |
Figura 5.28: Distribucién de esfuerzo de Von Mises Figura 5.29: Distribucién de esfuerzo de Von Mises
oum en el acero medido en kN/m? de la simulacién oum en el acero medido en kN/m? de la simulacién
realizada con hexaedros y prismas. realizada con tetraedros.

También se realizo la simulacion del problema en el programa ANSYS, en donde
se utilizé6 una malla con 7616 nudos y 6125 elementos de ocho nudos, utilizando el
elemento “SOLID185” de la libreria de ANSYS, como se muestra en la Figura 5.30
y en la Figura 5.31. A diferencia del enmallado con elementos hexaédricos realizado
por GMSH, este enmallado no utiliza prismas, sino que acomoda los hexaedros para
que lleguen al centro del cilindro.

Se utilizo la opcién de integracion del elemento ”Simple enhaced strain”, la cual
presenta diferencias en la formulacién con el elemento hexaédrico implementado en
este trabajo, ya que agrega en algunos elementos 9 grados de libertad internos para
evitar el error de bloqueo por cortante, tal como se menciona en la Subseccion 5.1.3.

Los desplazamientos en los nudos de la simulaciéon realizada en el programa
ANSYS se muestran en la Figura 5.32. La distribucién del esfuerzo principal me-
nor oz se muestra en la Figura 5.33 y la distribucién del esfuerzo de Von Mises oy,
se muestra en la Figura 5.34.
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Figura 5.30: Malla de elementos finitos hexaédri
en el programa ANSYS.

ANSYS
NODAL SOLUTTON 201982
STEP=1 AUG 12 2020
suB =1 02:19:52
TIME=:
usum (AVG)
RSYS=0
DMX =.435E-07
SHN =.276E-09
SMX =.435E-07
.276E-09 +989E-08 .195€-07 .291E-07 +387E-07
.508E-08 .147€-07 .243€-07 .339E-07 .435E-07

Figura 5.32: Configuracién deformada y norma del
vector de desplazamiento en metros de la simulacién
realizada en ANSYS

COS

AUG 12 2020
02:07:27

Figura 5.31: Malla de elementos finitos hexaédricos
en el programa ANSYS.

LH

AUG 12 2020
02:59:55

NODAL SOLUTTON

—
-.002647 -.001877 601107 -.338€-03
-.001402 -.7236-03 .471E-04

-.003417
-.002262

-.003032

Figura 5.33: Distribucién de esfuerzo principal menor
o3 en el concreto, medido en kN/m? de la simulacién
realizada en ANSYS.
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ANSYS

NODAL SOLUTION 2015 R2
STEP=1 AUG 12 2020
03:07:28

SEQV (AVG)
DMX =.435E-07
SMN =.906E-03
SMX =.015807

— —
.906E-03 004217 .007529 .01084 .014152
002561 .005873 009184 .012496 .015807

Figura 5.34: Distribucién de esfuerzo de Von Mises o4 en el acero medido en kN/m2 de la simulacién realizada en
ANSYS.

5.2.4. Analisis de resultados

A partir de las soluciones calculadas por las tres simulaciones, se comparan los valores
de la norma del vector de deformacion, del esfuerzo principal menor o3 en el concreto
y del esfuerzo de Von Mises o,,, en el acero. Estos valores se muestran en la Tabla 5.2.

El valor maximo de la norma del vector de desplazamiento en los nudos que se
utiliza como comparacion ocurre en todos los casos en la zona superior de la barra de
acero, como se puede observar en la Figura 5.24, la Figura 5.25 y en la Figura 5.32.

Por otro lado, el valor del esfuerzo principal menor en el concreto que se compara
en los tres casos, ocurre en la zona de contacto con el cabezal, como se puede observar
en la Figura 5.26, la Figura 5.27 y en la Figura 5.33.

El valor del esfuerzo de Von Mises en el acero o,,,, que se compara en los tres
casos, ocurre en la barra, cerca a la zona de unién con el cabezal, hacia el exterior del
cilindro, como se puede observar en la Figura 5.26, la Figura 5.27 y en la Figura 5.33.

Tabla 5.2: Comparacién de resultados

Programa Elemento Maéxima norma Esfuerzo prin- Esfuerzo de Von
del desplaza- cipal menor Mises (kN/m?)
miento (m) (kN/m?)

aqui desarrollado hexaedro de 8 nudos 4.31 x 10~ —3.33x 1073 1.82 x 102

PEFiCA 2.0 tetraedro de 4 nudos 4.08 x 107¢ —2.48 x 1073 1.66 x 1072

ANSYS hexaedro de 8 nudos 4.35 x 1076 —3.41 x 1073 1.58 x 1072

con enriquecimiento de
la deformacién (SO-
LID185)
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De los datos recopilados en la Tabla 5.2, se observa en los valores de la norma del
vector de desplazamiento que la simulacién con elementos hexaédricos en el programa
desarrollado difiere un 5.3 % con respecto a la simulacién con la malla de elementos
tetraédricos y un 0.9 % en relacién con el programa ANSYS.

También se observa que en los valores de esfuerzo principal menor o3 en la base
de la presa, la simulacion con elementos hexaédricos en el programa desarrollado
difiere un 25.5 % con respecto a la simulacién con la malla de elementos tetraédricos
y un 2.4 % en relacién con el programa ANSYS. Lo anterior indica una aproximacion
satisfactoria del programa desarrollado para elementos hexaédricos en comparacion
con ANSYS y un resultado aceptable de la simulacién con elementos tetraédricos,
recordando que el orden de aproximacion del elemento hexaedro es mayor al tetrae-
dro.

Con respecto a los valores de esfuerzo de Von Mises o,,, en la union entre la barra
y el cabezal, la simulacion con elementos hexaédricos en el programa desarrollado
difiere un 8.8 % con respecto a la simulacién con la malla de elementos tetraédricos
y un 13.1% en relacién con el programa ANSYS.

5.2.5. Analisis de sensibilidad

Se realiz6 un analisis de sensibilidad de la densidad de la malla con elementos he-
xaédricos, simulando el mismo problema con 8 mallas de diferente cantidad de ele-
mentos.

En la Figura 5.35 se indica el valor maximo absoluto para la malla en funcién
de la cantidad de elementos finitos, correspondiente a la norma del desplazamiento
(mm), el esfuerzo equivalente de von Mises en el acero (kN /m?) y el esfuerzo principal
menor en el concreto (kN/m?). Allf se observa que los resultados son asintéticos con
el incremento del ntimero de elementos de la malla.

5.3. Analisis de costo computacional

A continuacién se presenta la comparacién del costo computacional asociada al ti-
po de elemento finito y a la funcién intrinseca de GNU-OCTAVE (compatible con
MATLAB) utilizada para resolver el sistema de ecuaciones simulténeas.

5.3.1. Comparacion del costo computacional por tipo de elemento

En la Tabla 5.3 se indica el tiempo de ejecucion de las simulaciones para los dos ejem-

plos de aplicacion, con mallas de igual cantidad de nudos y con elementos finitos he-
xaédricos y tetraédricos, utilizando GNU-OCTAVE y MATLAB. Alli se observé que
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Figura 5.35: Valores maximos absolutos en la malla en funcién del nimero de elementos finitos de 8 mallas de elemen-
tos hexaédricos, correspondientes a: (a) la norma del desplazamiento de la malla (mm), (b) el esfuerzo equivalente
de von Mises en el acero (kN/m?2) y (c) el esfuerzo principal menor en el concreto (kN/m?2)

Tabla 5.3: Tiempos de ejecucién del programa desarrollado, en GNU OCTAVE y MATLAB, con elementos hexaédricos

y tetraédricos

Simulacién Programa Tipo de elemento finito  Tiempo de ejecucién (s)
presa Hoover GNU-OCTAVE hexaedro de 8 nudos 659

presa Hoover GNU-OCTAVE tetraedro de 4 nudos 1455

presa Hoover MATLAB hexaedro de 8 nudos 166

presa Hoover MATLAB tetraedro de 4 nudos 168

pull out GNU-OCTAVE hexaedro de 8 nudos 565

pull out GNU-OCTAVE tetraedro de 4 nudos 1068

pull out MATLAB hexaedro de 8 nudos 190

pull out MATLAB tetraedro de 4 nudos 196

el tiempo de ejecucion con la malla de elementos hexaédricos es aproximadamente
un 51 % menor que con la malla de elementos tetraédricos utilizando GNU-OCTAVE
y un 2% utilizando MATLAB. Lo anterior demuestra la eficiencia del elemento he-
xaédrico de 8 nudos con respecto al elemento tetraédrico lineal de 4 nudos.
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Tabla 5.4: Tiempos de ejecuciéon del programa en MATLAB utilizando la sintaxis indicada y el comando linsolve
con la opcién SYM, en una simulacién con 8862 nudos, en las diferentes etapas del proceso de andlisis. Tiempos en
segundos (s)

Solucionador T1 T2 T3 T4 T5 T6 T7 Tiempo
total

UAA = (KAA) (FAA— KAB*xUBB) 1.0 0.3 429 0.9 94.4 3.0 2.0 144.4
linsolve con opcién SYM 0.8 0.2 474 09 79.4 2.8 2.0 133.5

Tabla 5.5: Tiempos de ejecucién del programa en GNU-OCTAVE utilizando la sintaxis indicada y el comando linsolve
con la opcién SYM, en una simulacién con 8862 nudos, en las diferentes etapas del proceso de analisis. Tiempos en
segundos (s)

Solucionador T1 T2 T3 T4 T5 T6 T7 Tiempo
total

UAA = (KAA) (FAA - KAB * UBB) 90.8 3.7 198.2 22.3 128.6 65.8 47.2 556.6

linsolve con opcién SYM 89.7 3.7 197.2 223 122.1 65.2 47.1 547.4

5.3.2. Comparacion del costo computacional de acuerdo al método de
solucién de ecuaciones simultaneas

La formulacién del problema mecanico elastico tridimensional conduce a calcular los
desplazamientos en los nudos de la malla, mediante la resolucién de un sistema de
ecuaciones simultaneas. Este tltimo estd definido por una matriz de rigidez simétrica
del solido. En los métodos de solucién de sistemas de ecuaciones simultaneas inclui-
dos en las funciones intrinsecas de GNU-OCtave, existe uno aplicable a matrices
simétricas, el cual requiere menos de operaciones que los métodos para matrices no
simétricas.

La implementacion de la funciéon 1insolve, propia del lenguaje de GNU-Octave
(compatible con MATLAB) mencionada en la Subseccién 4.5.1, redujo el tiempo de
ejecucion de la solucion del sistema de ecuaciones simultaneas. Los tiempos de eje-
cucion de la tarea relacionada con la solucién del sistema de ecuaciones se redujeron
alrededor de 15.8 % en MATLAB y 6.6 % en GNU-OCTAVE. Los tiempos totales en
la ejecucion del programa se redujeron alrededor de 7.5 % en MATLAB y 2.0% en
GNU-OCTAVE, como se muestra en la Tabla 5.4 y en la Tabla 5.5.

En las tablas mencionadas, T1 representa la etapa de la lectura de datos, T2 es la
designacién de los grados de libertad, T3 es el cdlculo de la matriz de rigidez, T4 es
la obtencion del vector de fuerzas, T5 es el calculo de desplazamientos y reacciones,
T6 el calculo de las deformaciones y esfuerzos y T7 la presentacion de resultados. La
tarea en donde se utiliza el solucionador del sistema de ecuaciones es T5.
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Capitulo 6

Conclusiones y recomendaciones

A continuaciéon se presentan las conclusiones de este trabajo final de maestria y
las recomendaciones para futuros trabajos de investigacién derivados del programa
desarrollado.

6.1. Conclusiones

Como conclusion general, la formulacién del método de los elementos finitos para el
analisis tridimensional estatico de sélidos con material elastico lineal, se puede imple-
mentar utilizando elementos hexaédricos de 8 nudos y prismas de 6 nudos, en lenguaje
interpretado GNU-OCTAVE y MATLAB. Asimismo la programacion estructurada
de dicha formulacion, la elaboraciéon del manual de usuario y la representacion grafi-
ca del pre y del post proceso, contribuyen potencialmente al aprendizaje del método
de los elementos finitos en la mecanica de solidos. A continuacién se presentan las
conclusiones especificas:

e El programa desarrollado permite la lectura de los datos del problema gene-
rados previamente en el entorno grafico de preproceso y la escritura de los
resultados en el formato de representacion grafica en el entorno de postpro-
ceso. Lo anterior se aplica particularmente para mallas de elementos finitos
hexaédricos y prismas.

e El campo del desplazamiento, el esfuerzo y la deformaciéon de un sélido bajo
la accién de cargas estaticas, se puede obtener utilizando el programa desa-
rrollado, mediante el método de los elementos finitos y utilizando elementos
hexaédricos y prismas. Los resultados del andlisis de: una presa de béveda bajo
el peso propio y la presion hidroestdtica y un ensayo de arrancamiento de una
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6.2.

barra de acero en un cilindro de mortero, son sustancialmente similares a los
obtenidos con un programa comercial reconocido.

En las simulaciones realizadas se observd que la diferencia del desplazamiento
y de los esfuerzos principales entre la malla de elementos hexaédricos y te-
traédricos, se debe al orden de aproximacién y a la mayor rigidez que ofrece un
volumen conformado por este 1ltimo tipo de elemento.

Los resultados representativos de las simulaciones realizadas para diferentes
densidades de malla, demostraron la convergencia hacia un valor comun.

La forma de escribir el cédigo del programa desarrollado en un lenguaje como
GNU-OCTAVE o MATLAB, mantiene la robustez del proceso de célculo, y
potencialmente facilita la comprensién de los procedimientos y la posibilidad
de ampliacion mediante nuevas subrutinas.

La simetria de la matriz de rigidez de la malla en problemas elasticos lineales
tridimensionales, permitié utilizar un método de soluciéon del sistema de ecua-
ciones simultaneas particular para matrices simétricas. Durante la ejecuciéon
del programa se observé que este ultimo, calculé los desplazamientos nodales
de la malla en menos tiempo, en comparacion con el método para matrices no
simétricas.

El tiempo de ejecucién de la simulacion de los ejemplos de aplicacién con la
malla de elementos hexaédricos, fue menor que aquella con elementos tetraédri-
cos conservando el mismo nimero de nudos. Lo anterior demuestra la eficiencia
del elemento hexaédrico de 8 nudos con respecto al elemento tetraédrico lineal
de 4 nudos.

Recomendaciones para futuros trabajos

A continuacion se presentan algunas sugerencias para futuros trabajos que se pueden
realizar a partir del presente trabajo final de maestria:

Para evitar el error denominado bloqueo por cortante, se podria implementar
el elemento finito hexaédrico con enriquecimiento de la deformacién, el cual
estd incluido en la libreria de elementos finitos de ANSYS. Esta técnica intro-

duce selectivamente nuevos grados de libertad y estda basada en los trabajos
desarrollados de Simo y Rifai (Simo & Rifai, 1990).
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e Con el propdsito de mejorar la precision de la integracion numérica del elemento
hexaédrico de ocho nudos, se propone implementar dicha integracion con un
nimero mayor a ocho puntos de Gauss sobre el elemento.

e Para mejorar la precision de la solucién del problema se pueden implementar
elementos finitos tetraédricos y hexaédricos de segundo orden.

e Con el fin de utilizar programas de generacién de mallas que producen ele-
mentos finitos piramidales, se recomienda la implementacién de este tipo de
elemento.

e Se recomienda desarrollar los algoritmos de andlisis dindmico y no lineal pa-
ra solucionar problemas mecéanicos tridimensionales. Lo anterior con el fin de
acercarse al comportamiento real de los sélidos.
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Capitulo 7

Manual del usuario del programa

En este capitulo se describen los principales aspectos para utilizar el programa desa-
rrollado en este trabajo final de maestria, para resolver problemas mecanicos tri-
dimensionales. Tal como se mencion6 en el procedimiento general presentado en la
Seccién 4.1, el proceso consta de tres partes principales:

e El preproceso o la construccion del archivo que contiene las entidades geométri-
cas y las caracteristicas fisicas, utilizando el programa gratuito GMSH.

e El proceso o la solucion al problema mecédnico tridimensional mediante las ru-
tinas modificadas y generadas en este trabajo final de maestria, en el programa
GNU-OCTAVE.

e El post proceso o la representacion de los resultados en el dominio del problema,
utilizando el médulo de post proceso del programa GMSH.

Las siguientes secciones contienen un breve manual de usuario para cada una de
las partes mencionadas. Una descripcion més detallada de cada una de éstas se puede
consultar en la referencia (Linero et al., 2020).

7.1. Creacion de la geometria y el enmallado en el programa
GMSH

En esta seccion se describe el procedimiento para crear la geometria, la designaciéon
de caracteristicas fisicas y la malla de elementos finitos hexaédricos y prismas desde
el médulo grafico de preproceso del programa GMSH.

El enmallado con elementos hexaédricos descrito en este trabajo, se logra a través
de un proceso de recombinacion de una malla estructurada de elementos tetraédricos.
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Este enmallado con elementos finitos hexaédricos comparte algunas de las etapas
utilizadas para construir mallas de elementos tetraédricos mostrado en la referencia
(Linero et al., 2020), pero adicionalmente se deben cumplir ciertas condiciones.

Estas condiciones son debidas a los algoritmos de recombinacién de elementos,
propios del programa GMSH. Las condiciones son:

e Las superficies que conforman los solidos deben estar delimitadas por cua-
drilateros. En caso de requerirse formas complejas, se pueden realizar divisiones
a las superficies de manera que se formen cuadrilateros, como se mostré para
los ejemplos en la Figura 5.2 y Figura 5.18.

e Todas las lineas que conforman cada uno de los volimenes del sélido debe
tener asignado un parametro llamado Transfinite Curve, el cual establece la
cantidad de las divisiones que la linea tendra cuando se realice el enmallado.
Cuanto mayor sea su valor, mas elementos finitos tendra la futura malla.

e Los valores de la propiedad Transfinite Curve asignados a las lineas del
problema deben ser consistentes en la geometria considerando la futura malla
de elementos. Esto quiere decir que si se desea, por ejemplo, asignarle a una cara
de un cuadrilatero m divisiones en la malla, la cara opuesta también debera
tener m divisiones. Esto se ilustra en la Figura 7.1 y en la Figura 7.2.
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Figura 7.2: Asignacién de la propiedad
Transfinite Curve a las lineas de la seccién.
Figura 7.1: Asignacién de la propiedad Las lineas con letras iguales representan las que
Transfinite Curve a las lineas de la seccién. deben tener el mismo valor de esta propiedad.
Las lineas con letras iguales representan las que
deben tener el mismo valor de esta propiedad.

e Todas las superficies que conforman los volumenes del sélido del problema,
deben también tener asignada la propiedad Transfinite Surface. Esta pro-
piedad aplicada a las superficies, define el orden de sus vértices, los cuales se
deben seleccionar de forma consecutiva.

e Todos los volimenes que conforman el sélido del problema, también deben
tener asignada la propiedad Transfinite Volume. En esta propiedad aplicada
en los volumenes, se deben definir los vértices que lo conforman.

e Una vez cumplidos los anteriores requisitos, se debe dar la instruccién de con-
vertir la malla de elementos tetraédricos en elementos hexaédricos, a través de
la instruccién Recombine Surface.

Por otro lado, en los enmallados generados por GMSH los elementos prismas se
utilizan solamente como elementos adicionales a los hexaedros para cubrir geometrias
con caracteristicas muy especificas, como por ejemplo la zona cercana al eje de la
cuarta parte del cilindro mostrado en la Seccion 5.2.

Para una descripcion mas detallada del procedimiento para la generacién de ma-
llas con elementos tetraédricos, asi como para una ampliacién a la informacién pre-
sentada en este capitulo, se puede consultar el capitulo 10 de la referencia (Linero

© Alejandro Robayo Zapata



100 Desarrollo de un programa didactico de elementos finitos para problemas eldsticos lineales en tres dimensiones

et al., 2020) o el manual de usuario del programa GMSH (Geuzaine & Remacle,
2019).

7.1.1. Consideraciones generales

El programa GMSH permite construir la geometria y asignarle las caracteristicas
fisicas al problema mediante érdenes ejecutadas a través de los botones que presenta
su interfaz grafica, o también mediante la creaciéon o modificaciéon de un archivo
en formato ASCII de extension .geo. En este archivo se almacena la secuencia de
comandos que forma la geometria del problema y la asignacién de las caracteristicas
fisicas y de su enmallado.

Es posible crear la geometria del problema a través de la modificacion directa de
archivo .geo o mediante los comandos de los botones en pantalla o utilizando las
dos opciones, segin convenga.

Cada orden realizada mediante las opciones del entorno grafico para la creacién
de la malla, tendréa una linea en el archivo .geo asociada. Este archivo se puede
consultar o modificar en cualquier momento, y resulta ttil cuando se requiere, por
ejemplo, deshacer la ultima accion realizada. Para esto basta borrar la tltima linea
del archivo .geo y volver a cargarlo.

El archivo .geo se puede abrir a través del menu lateral de GMSH haciendo click
en Modules > Geometry > Edit script. Al realizar modificaciones directamente
en él, se deben guardar los cambios.

Si se desea volver a cargar el archivo .geo, se hace clic en Modules > Geometry
> Reload script.

Para iniciar un nuevo archivo, se hace clic en File > New, a continuacién se
selecciona la carpeta de trabajo y se escribe el nombre del archivo con extensiéon
.geo.

En seguida se selecciona el tipo de librerias internas para la visualizacion. Para
este tipo de problemas es conveniente seleccionar OpenCASCADE.

Por otro lado, en la mayoria de los cuadros de didlogo que genera el programa
GMSH, la tecla de confirmacion es e, mientras que la tecla para terminar es q.

7.1.2. Construccién de entidades geométricas

En el entorno grafico de GMSH se pueden definir los puntos, lineas rectas o curvas,
superficies y volumenes que conforman la geometria del problema. Todas estas ins-
trucciones tienen asociada una instruccion en el archivo de extension .geo. En la
Figura 7.3 se muestran las opciones para la construccién de entidades del entorno

grafico de GMSH.
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Figura 7.3: Opciones de construccién de entidades del entorno grafico de GMSH.

7.1.2.1. Construcciéon de puntos

Para crear un punto se selecciona en el menu lateral Modules > Geometry >
Elementary entities>> Add > Point. A continuacion se introducen las coordenadas
del punto en la pestana Point de la ventana Elementary Entity Context y se
hace click en Add.

También es posible indicar graficamente la posicion del punto, indicandola con el
puntero sobre la cuadricula. Para modificar la precision del puntero sobre la cuadricu-
la, se modifican los parametros X Y Zsnap que aparecen en la ventana Elementary
Entity Context.

Cada vez que se crea un nuevo punto, en el archivo de extension .geo se adiciona
una linea con la sintaxis que se muestra a continuacion:

Point(ipunto) = {xcoord, ycoord, zcoord, tamalla}

En la anterior instruccién, ipunto es el identificador del punto, xcoord, ycoord
y zcoord son las coordenadas x,y,z del punto y tamalla define el tamano de los
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elementos finitos sobre el punto. El parametro tamalla en el caso de la construccién
de mallas con elementos hexaédricos utilizando la instrucciéon Transfinite, no sera
tenido en cuenta, por lo que se puede dejar con valor igual a cero.

7.1.2.2. Construccion de lineas

Luego de definir los puntos, se construyen las lineas seleccionando en el meni Mo-
dules > Geometry > Elementary entities> Add > Line. A continuacién se
hace clic sobre el punto inicial de la linea y luego clic sobre el punto final. Se puede
continuar creando nuevas lineas o terminar presionando la tecla q.

La instruccion generada en el archivo con extension .geo es:

Line(ilinea) = {inudo, jnudo}

donde ilinea es el identificador de la linea, inudo es el identificador del nudo inicial
y jnudo es el identificador del nudo final.

Adicionalmente, se pueden construir otros tipos de lineas curvas seleccionando
Modules > Geometry > Elementary entities> Add > y a continuacion selec-
cionar entre:

e Spline crea una linea curva que pasa por los puntos seleccionados. Su sintaxis
es:
Spline(ilinea) = {inudo, jnudo, knudo. ..}

e Bezier crea una curva de Bézier, la cual es una curva que une el primero y
el ultimo punto seleccionado, y utiliza los puntos intermedios como puntos de
control de su curvatura. Su sintaxis es:

Bezier(ilinea) = {inudo, jnudo, knudo. ..}

e B-Spline crea una linea que une el primer y el dltimo punto, utilizando los
puntos intermedios como control. Para ello utiliza una aproximacién cubica.
Su sintaxis es:

BSpline(ilinea) = {inudo, jnudo, knudo. ..}

e Circle crea un arco circular. En su sintaxis se indican las coordenadas x, y ,z
del punto de inicio, el radio, el angulo inicial y dngulo final del arco. Su sintaxis
es de la forma:

BSpline(ilinea) = {coorzi, cooryi, coorzi, radio, angi,angj}
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e Ellipse crea un arco de elipse. En su sintaxis se indican las coordenadas x, y ,z
del punto de inicio, el radio en x, el radio en y, el angulo inicial y angulo final
del arco. Su sintaxis es de la forma:

BSpline(ilinea) = {coorzi, cooryi, coorzi, radiox, ...
radioy, anguli, anguly}

7.1.2.3. Construccién de superficies

Para construir una superficie se selecciona Modules > Geometry > Elementary
entities > Add > Plane surface. A continuacién se da clic en las lineas rectas
o curvas que forman el contorno de la superficie, y una vez seleccionadas todas las
lineas se oprime la tecla e. Para finalizar la creacién de superficies se presiona la tecla
q.

Por cada superficie creada, en el archivo con extensién .geo se adicionan dos
instrucciones:

CurveLoop(icurciclo) = {ilinea, jlinea, klinea . . . }

PlaneSurface(isuperf) = {icurciclo}

La primera instruccion establece un grupo de lineas conectadas por sus extremos,
formando un ciclo de curvas. En ella icurciclo es el identificador del ciclo de curvas, y
ilinea, jlinea, . .. representan los identificadores de las lineas que conforman el ciclo.

La segunda instruccién establece la superficie a partir del ciclo de curva. En ella
isuper f es el identificador de la superficie y el parametro icurciclo es el identificador
del ciclo correspondiente.

7.1.2.4. Construccion de volimenes

La definicion de los volimenes se realiza seleccionando Modules > Geometry >
Elementary entities> Add > Volume. A continuacién se da clic en las superficies
que conforman el contorno del volumen y luego se oprime la tecla e. Para finalizar
la creacion de volimenes se presiona la tecla q.

Por cada volumen creado, se adicionan dos instrucciones al archivo de extension
.geo :

SurfaceLoop(isupciclo) = {isup, jsup, ksup...}
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PlaneSurface(isuperf) = {isupciclo}

La primera instruccion establece un grupo de superficies conectadas por sus la-
dos formando un ciclo de superficies. En ella isupciclo es el identificador del ciclo
de superficies, y isup, jsup, ... representan los identificadores de las superficies que
conforman el ciclo. La segunda instruccion establece el volumen a partir del ciclo de
superficies. En ella 1vol es el identificador del volumen y el parametro isupciclo es el
identificador del ciclo correspondiente.

7.1.3. Construccion de formas comunes

El programa GMSH permite ademéds construir directamente formas geométricas, ya
sean superficies o volimenes, generando de manera automatica los puntos, lineas o
superficies requeridos. Algunas de éstas formas se muestran a continuacién:

7.1.3.1. Creacién de un rectangulo

Se puede crear desde Modules > Geometry > Elementary entities> Add >
Rectangle. Esto abre una ventana desde donde se introducen las coordenadas z, v, 2
del extremo inferior izquierdo, asi como su base y altura, representados como DX y
DY en la ventana de creacion desplegada. Una vez se definen éstos parametros, se da
clic en el botén Add. Para finalizar se presiona la tecla q.

Esta instruccién genera una linea al archivo con extensiéon .geo de la forma:

Rectangle(idsu) = {extz, exty, extz, disz, disy, jnudo}

donde idsu es el nimero identificador de superficie, extx, exty, extz son las coorde-
nadas del extremo inferior izquierdo, disx, disy son la base y la altura del rectangulo
y rede es un parametro para redondear las esquinas.

7.1.3.2. Creacién de un circulo o elipse

Se puede crear desde Modules > Geometry > Elementary entities> Add >
Disk. Esto abre una ventana donde se introducen las coordenadas x, y, z del centro
del circulo o elipse, asi como su radio en X y radio en Y. Si el valor del radio en X es
igual al radio en Y, se define un circulo, en caso contrario se define una elipse.Una vez
se definen éstos parametros, se da clic en el boton Add. Para terminar se presiona
la tecla q.
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Esta instruccion genera una linea al archivo con extension .geo de la forma:
Disk(idsu) = {cenx, ceny, cenz, radx, rady}

donde idsu es el nimero identificador de superficie, cenx, ceny, cenz son las coorde-
nadas del centro, radz, rady son los radios en direccién x y .

7.1.3.3. Paralelepipedo regular

Para crearlo, se selecciona Modules > Geometry > Elementary entities > Add
> Box. Esto despliega una ventana donde se introducen las coordenadas z,vy, z del
extremo inferior izquierdo del paralelepipedo, asi como sus dimensiones en z,v, 2,
representados como DX, DY y DZ en la ventana desplegada. Una vez se han definido
éstos pardametros, se da clic en el boton Add. Para terminar se presion la tecla q.
Esta instruccién genera una linea al archivo con extensiéon .geo de la forma:

box(idvo) = {extx, exty, extz, disz, disy, disz}

donde 2dvo es el nimero identificador de volumen, extx, exty, extz son las coorde-
nadas del extremo inferior izquierdo y disz, disy, disz son las dimensiones x, ¥y, z del
paralelepipedo.

7.1.3.4. Creacion de un cilindro

Se puede crear desde Modules > Geometry > Elementary entities > Add >
Cylinder. Esto despliega una ventana donde se introducen las coordenadas z,y, 2
del centro del circulo de la base en las casillas Center base X, Center base Y y
Center base Z. Asimismo se introducen sus proyecciones en X, Y y Z en las casillas
Axis DX, Axis DY y Axis DZ.

El radio del circulo de la base se ingresa en la casilla Radius. En la casilla Angle
se define la porcion del cilindro que se desea crear en radianes, siendo 27 el circulo
completo. valores menores a éste generan la extrusion del sector del circulo indicado.
Una vez se definen éstos parametros, se da clic en el botéon Add. Para terminar se
presiona la tecla q.

Esta instruccion genera una linea al archivo con extension .geo de la forma:

Cylinder(idvo) = {cenz, ceny, cenz, axdzx, axdy, axdz, radi, angl}

donde idvo es el nimero identificador de volumen, cenx, ceny, cenz son las coorde-
nadas del centro del circulo de la base, axdz, axdy, axdz son las proyecciones del eje
longitudinal z, y y 2. El parametro radi es el radio del circulo de la base y el angl
es el angulo en radianes del sector circular.
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7.1.4. Construcciéon de entidades geométricas mediante extrusion

Los procesos de extrusion que se describen en esta secciéon permiten generar un
volumen a partir de la rotacion o traslaciéon de una o varias superficies.

7.1.4.1. Creacion de volimenes a partir de la extrusién por traslacién de
superficies

Para generar el volumen por traslacién de superficies, se selecciona Modules >
Geometry > Elementary entities > Extrude > Traslate. Lo anterior despliega
una ventana donde se debe indicar la longitud de la extrusién por traslacién para
cada eje x,y, z, en las casillas DX, DY yDZ respectivamente.

A continuacién en Selection mode se escoge Surfaces. Luego en el entorno
grafico se seleccionan las superficies y una vez seleccionadas se oprime la tecla e.
Para finalizar se oprime la tecla q.

Al realizar lo anterior, en el archivo de extension .geo se genera una instruccién
que tiene la forma:

Extrude{dz, dy, dz}{Surface{isupl,isup2,...};...}

donde dz, dy y dz son las longitudes de la extrusién en direcciones z, y v z. isupl,
1sup2... son los identificadores de las superficies que serdn extruidas.

7.1.4.2. Creacion de voliimenes a partir de la extrusién por rotacién de
superficies

Para generar el volumen por rotacion de superficies, se selecciona Modules > Geo-
metry > Elementary entities > Extrude > Rotate. Se despliega una ventana
donde se debe indicar las coordenadas x, y y 2z del origen del eje que define la rota-
cién. Estas coordenadas x, y y z se introducen en las casillas Axis point x, Axis
point y y Axis point z.

También es necesario definir las componentes x, y y z que definen la direccién
del eje de rotacion. Esto se hace en las casillas Axis DX, Axis DY y Axis DZ. A
continuacion se define el angulo en radianes de la extrusiéon en la casilla Angle.

Una vez definidas los anteriores parametros, en Selection mode se escoge Surfa-
ces. Luego en el entorno grafico se seleccionan las superficies y una vez seleccionadas
se oprime la tecla e. Para finalizar se oprime la tecla q. De forma automatica, en el
archivo de extensién .geo se agrega una instruccién que tiene la forma:

Extrude{{dz, dy,dz}, {xp, yp, zp}, ang}{Surface{isupl,isup2,...};...}
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donde dx, dy y dz son componentes que definen la direccién del eje de rotacion, xp,
yp y zp son las coordenadas del punto inicial del eje de rotacion, ang es el angulo
en radianes de la extrusion, y isupl, isup2... son los identificadores de las superficies
que seran extruidas. La ubicacién de estos comandos en el entorno grafico de GMSH
se muestra en la Figura 7.4 y la ventana de selecciéon de pardmetros para extrusion
por rotacién se muestra en la Figura 7.5.

A Gmsh - F\hooverMan7.geo = B8 =
File Tools Window Help
| @ Modules Select entities
Elementary Operation Context = [
£ Geometry [Press 'e to end selection, 'u' to undo last selection or 'q’ to abort] e
[ Elementary entities
Set geometry kernel Rotate =
Add
Transform 409 AxispointX 0 Axis DX
B [Extrude
Translate 0 Axis puml b g 1 Axis DY
Rotate |« 0 AxispointZ 0 Axis DZ
Pipe
Boolean 0.72*Pi Angle
Fillet
spitt curve
o Extrude mesh
Coherence
| Physical groups 5 Mesh layers v Recombine
Reload script
Remove last script command
Edit script
Mesh y All entities ¥ Selection mode:
Solver
X
-3
=oxvYz@11s Done reading 'F\hooverMan? geo' Figura 7.5: Ventana de seleccion de pardmetros para

extrusién por rotacién

Figura 7.4: Ubicacién de los comandos de extrusién
por rotacion.

7.1.5. Asignacion de entidades fisicas para el proceso en PEFiCA

En esta seccion se indica la forma de asignar las propiedades mecanicas de los mate-
riales, la definicién de desplazamientos, la aplicacion de cargas puntuales y las cargas
distribuidas a los elementos de la geometria.

7.1.5.1. Propiedades mecanicas de los materiales

Las propiedades mecénicas de los materiales se asignan a los volimenes. Es posi-
ble tener varios materiales dentro del dominio del problema, pero cada uno de los
volimenes que conforman el dominio del problema solo puede estar asociado a un
solo tipo de material.

Para asignarlas, se debe desplegar la ventana Physical groups relacionada con
volumenes, seleccionando Modules > Geometry > Physical groups > Add >
Volume.

Alli se asignan las propiedades del material al volumen mediante la siguiente
sintaxis:
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CATE EYQU = eyou POIS = pois GAMM = gamm TIPR = tipr

donde eyou es el moédulo de Young, pois es la relacién de Poisson, gamm es el
peso especifico y tipr es el tipo de problema, el cual para este tipo de problemas
tridimensionales es TIPR = 30. No debe hacer espacios antes o después del caracter

A continuacién se seleccionan los volimenes que estan asociados al material y se
oprime la tecla e. Para finalizar se oprime la tecla q.

Cuando se utiliza el procedimiento anterior, en el archivo de extensiéon .geo se
agrega una instruccién que tiene la forma:

Physical Volume(”CATE EYOU = eyou POIS = pois
GAMM = gamm TIPR = tipr”) = {ivol, jvol, ... };

donde 2vol, jvol . . . son los identificadores de los volimenes a los que se le asignara
el material.

7.1.5.2. Definicién de desplazamientos

Para asignar los desplazamientos conocidos del problema sobre superficies, se debe
desplegar la ventana Physical groups relacionada con superficies, seleccionando
Modules > Geometry > Physical groups > Add > Surface.

Si el desplazamiento conocido estd ubicado en puntos, se debe desplegar la venta-
na Physical groups relacionada con puntos, seleccionando Modules > Geometry
> Physical groups > Add > Point.

En la ventana desplegada se asignan los valores del desplazamiento con la siguien-
te sintaxis:

DISP UX = ux UY = uy UZ = uz

donde ux, uy y uz son los valores conocidos de las componentes de desplazamiento
en direcciones x, y y z. Solo se debe indicar la componente de valor conocido. Si por
ejemplo en una superficie solo se conoce el valor del desplazamiento en y, la sintaxis
es: DISP UY = uy. No deben haber espacios antes o después del caracter =.

A continuacién se seleccionan las superficies o puntos que estdn asociados al
material y se oprime la tecla e. Para finalizar se oprime la tecla q.

Al seguir los pasos anteriores, en el archivo de extensién .geo se agrega una
instruccion que tiene la forma:

PhysicalSurface(”DISP UX = uz UY = uy UZ = uz”) = {isup, jsup,...};
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donde isup, jsup ... son los identificadores de superficie a las que se les asigné el
desplazamiento conocido.
Si el desplazamiento se asigna a puntos, la instruccion es que se agrega es:

PhysicalPoint(”DISP UX = ux UY = uy UZ = uz”) = {ipun, jpun, ...},

donde ipum, jpum... son los identificadores de los puntos.

7.1.5.3. Aplicacién de cargas puntuales

Las cargas puntuales se pueden asignar sobre puntos o superficies. Para asignarle una
carga puntual a una superficie, se debe desplegar la ventana Physical groups rela-
cionada con superficies, seleccionando Modules > Geometry > Physical groups
> Add > Surface.

Si la carga puntual esta ubicada en puntos, se debe desplegar la ventana Physical
groups relacionada con puntos, seleccionando Modules > Geometry > Physical
groups > Add > Point.

En esta ventana se debe escribir la carga puntual con la siguiente sintaxis:

LOADFX = fo FY = fyFZ = fz

donde fx, fy v fz son los valores de las componentes de la carga puntual en
direcciones x, y y z. Si se aplica una sola componente, no es necesario escribir las
que son iuales a cero. No deben haber espacios antes o después del caracter =.

En seguida se seleccionan las superficies o puntos que estan asociados al material
y se oprime la tecla e. Para finalizar se oprime la tecla q.

Lo anterior genera en el archivo de extensién .geo una instruccién que tiene la
forma:

PhysicalSurface("LOAD FX = fx FY = fy FZ = f2") = {isup, jsup, ... };
donde isup, jsup ... son los identificadores de superficie a las que se les asigné el
desplazamiento conocido.
Si la carga se asigna a puntos, la instrucciéon es que se agrega es:

PhysicalPoint("LOAD FX = fz FY = fy FZ = f2”) = {ipun, jpun,...};

donde ipum, jpum... son los identificadores de los puntos.
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7.1.5.4. Aplicacién de presiones

Para asignar las presiones conocidas del problema sobre superficies, se debe desplegar
la ventana Physical groups relacionada con superficies, seleccionando Modules >
Geometry > Physical groups > Add > Surface.

En esta ventana se debe escribir, dependiendo del tipo de presién la siguiente
sintaxis:

e Si la presién es uniforme con componentes definidos en el sistema global de
coordenadas:
PRES WX = wz WY = wy WZ = wz

donde wx, wy y wz son los valores de las componentes de presion uniforme en
direccion z, y y z. No deben haber espacios antes o después del caracter =.

e Si la presién es uniforme y normal a la superficie:
PRES WN = wn

donde wn es el valores de la presion uniforme normal a la cara en la que actia,
considerada positiva si entra a la superficie.

e Si se aplica una presion hidraulica:
PRES GAWA = gawa HEWA = hewa

donde gawa es el peso especifico del agua v, y hewa es el nivel del agua con
respecto al origen coordenado global h,,.

A continuacién se seleccionan las superficies que estan asociados a la presion y
se oprime la tecla e. Para finalizar se oprime la tecla q. En la Figura 7.6 se muestra
un ejemplo de asignacion de una presion hidroestatica. El procedimiento anterior
genera en el archivo de extensién .geo una instruccion que tiene la forma, segin
corresponda a los casos anteriores:

e Para presion uniforme en coordenadas globales:

PhysicalSurface(”PRES WX = wx WY = wy WZ = wz”) = {isup, jsup,...};

e Para presién uniforme normal a al superficie:

PhysicalSurface(”PRES WN = wn”) = {isup, jsup,...};
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e Para presion hidroestatica:

PhysicalSurface(”PRES GAWA = gawa HEWA = hewa”) = {isup, jsup, ... };

donde isup, jsup ... son los identificadores de superficie a las que se les asigné el
desplazamiento conocido.

A Gmsh - FAhooverH.geo =TE] %
File Tools Window Help \

E‘g""%"u'% A Select surfaces
eometry [Press ‘e’ y "
Elementary entities 220 €1\ S0 Selechon 0r g o mort]
[ Physical groups z T
[ Add
Point
Curve
Surface f¢——
Volume
Remove
Reload script
Remove last script command
Edit script
Mesh
Solver

'\ Physical Group Context o e [

PRES GAWA=0 81 HEWA=180]| v Name \

v Automatic numbering

£

SE0XYZQ 118 Hd Done reading 'F-\hooverH.geo' [

Figura 7.6: Ejemplo de asignacién de una presién hidroestatica sobre una superficie.

7.1.6. Preparaciéon de entidades geométricas para el enmallado

Como se menciond al principio de esta seccién, para lograr crear una malla estructu-
rada de elementos hexaédricos se requiere la asignacion de la propiedad Transfinite
a las lineas, superficies y volimenes que conforman el dominio del problema.

7.1.6.1. Preparacién de las lineas

Todas las lineas que conforman el dominio del problema debe tener asignado el
parametro Transfinite Curve, el cual determina la cantidad de divisiones que ésta

© Alejandro Robayo Zapata



112 Desarrollo de un programa didactico de elementos finitos para problemas eldsticos lineales en tres dimensiones

tendra cuando se realice el enmallado. Esto se logra desplegando la ventana Modules
> Mesh > Define > Transfinite > Curve.

A continuacién se selecciona el numero n de nudos que tendra la linea en el
enmallado. Cabe mencionar que el nimero de divisiones que tendra la linea es n — 1.

También se selecciona el tipo de divisiones que se realizaran, donde la opcion
Progression estd relacionada con una progresién geométrica que utiliza un coefi-
ciente de progresion que se introduce en el cuadro Parameter. Por otro lado, la opcién
Bump establece un refinamiento hacia los extremos de la curva.

La opcién para el tipo de divisiones seleccionada en los ejemplos realizados en
este trabajo es Progression, con Parameter = 1, con lo cual se asignan divisiones
uniformes de acuerdo al niimero de puntos seleccionado.

Para realizar una malla con elementos hexaédricos, es recomendable planear cui-
dadosamente el nimero de divisiones que se realizaran en cada linea, buscando que la
futura malla tenga coherencia. Asimismo, se debe garantizar que las caras opuestas
en las superficies cuadrilaterales tengan el mismo ntimero de divisiones.

En seguida se seleccionan las curvas a las que se les asignara la misma division y
se oprime la tecla e. Para finalizar se oprime la tecla q. Al realizar el procedimiento
anterior, en el archivo de extension .geo se crea una instruccion que tiene la forma:

TransfiniteCurve{ilinea, jlinea, ...} = npunto Using Progression param

donde linea, jlinea . .. son los identificadores de las lineas a las que se les asigna
la propiedad, npunto es el nimero de puntos que va a tener la curva y param es el
parametro de progresion.

7.1.6.2. Preparacion de las superficies

Para asignar la propiedad Transfinite Surface a las superficies, se debe desplegar
la ventana seleccionando Modules > Mesh > Define > Transfinite > Surface.
A continuacion se da clic en la superficie a la que se asignara la propiedad. Luego se
da clic en cada uno de los vértices que tiene esta superficie, cuidando de recorrer el
contorno de ésta sin omitir ningin punto. Una vez se seleccionan todos los vértices
de la superficie, se oprime la tecla e. Para finalizar se oprime la tecla q.

Para realizar el procedimiento anterior en algunos problemas con geometrias com-
plejas es conveniente utilizar las opciones que ofrece GMSH de visualizacién exclusiva
de ciertas entidades, para dejar visible solamente la superficie a la que se desee asignar
la propiedad Transfinite Surface.

La asignacion de la propiedad Transfinite Surface se logra seleccionando en la
barra de mentu superior Tools > Visibility, lo cual despliega una ventana en donde
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se pueden seleccionar los identificadores de las entidades que se quieren visualizar
exclusivamente, en este caso la superficie. Luego se da clic en Apply, y solamente se
visualizan las entidades seleccionadas.

Al realizar la asignacién de la propiedad Transfinite Surface, en el archivo de
extension .geo se crea una instruccién que tiene la forma:

Transfinite Surface{isup} = {ipun,jpun, kpun, ...}

donde isup es el identificador de la superficie a las que se les asigna la propiedad,
ipun, jpun, kpun, ... son los identificadores de los puntos que conforman el contorno
de la superficie.

7.1.6.3. Preparaciéon de los voliimenes

La ventana de asignaciéon de la propiedad Transfinite Volume se obtiene seleccio-
nando Modules > Mesh > Define > Transfinite > Volume. En seguida se da clic
en el volumen al que se le va a asignar la propiedad. A continuacion se seleccionan
los nudos que conforman el volumen.

Se recomienda realizar esta seleccion de vértices siguiendo las reglas de numera-
cién del hexaedro mostradas en la Subseccion 3.6.1 para el caso de volimenes con
forma de hexaedros, y las reglas de numeracién de la Subseccion 3.7.1 para el caso
de volumenes con forma de prisma o cuna. Una vez se seleccionan todos los vértices
del volumen, se oprime la tecla e. Para finalizar se oprime la tecla q.

Luego de la asignacién de la propiedad Transfinite Volumen, en el archivo de
extension .geo se crea una instruccién que tiene la forma:

TransfiniteVolumen{ivol} = {ipun,jpun,kpun,...}

donde 7vol es el identificador del volumen al que se asigna la propiedad, ipun, jpun, kpun, . ..
son los identificadores de los puntos que conforman su contorno.

7.1.6.4. Preparaciéon de los voliimenes

Luego de asignar la propiedad Transfinite a las curvas, superficies y volimenes,
que conforman el sélido del problema, se da la instruccion para que se combinen
los elementos tetraédricos de la futura malla estructurada y se formen elementos
hexaédricos y prismas, si se requiere.

Esto se logra al seleccionar Modules > Mesh > Define > Recombine. A conti-
nuacion se seleccionan todas las superficies del problema, manteniendo presionada la
tecla Ctrl y manteniendo el clic para crear de esta manera un rectangulo de seleccién
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que contenga todas las entidades del problema. A continuacion se oprime la tecla e
y luego para finalizar se oprime la tecla q.

Luego de realizar el proceso anterior, en el archivo de extensién .geo se crea una
instruccion que tiene la forma:

Recombine Surface{isup, jsup, ksup,...};

donde isup, jsup, ksup, . .. son los identificadores de las superficies seleccionadas.

7.1.7. Generacion de la malla

Una vez asignadas las propiedades de los materiales, los desplazamientos, las cargas,
y la propiedad Transfinite a las entidades geométricas que conforman el problema,
se genera la malla de elementos finitos haciendo clic en Modules > Mesh > 3D, u
oprimiendo la tecla 3.

Si luego de generar la malla se requiere modificar algin pardmetro de la geometria
o de la propiedad Transfinite, es posible recargar el archivo de extensién .geo
mediante Modules > Geometry > Reload script o también oprimiendo la tecla
del ntimero 0.

7.1.8. Creacién del archivo .msh

Con la malla generada correctamente mediante los procedimientos descritos en los
pasos anteriores, el programa GMSH permite exportar a un archivo de extension .msh
en formato ASCII de la version 2 de GMSH, el cual puede ser leido por el programa
PEFICA 2.0 con las modificaciones realizadas en este trabajo final de maestria. El
procedimiento es el siguiente:

e Hacer clic en el mentd superior en File > Export. Esto abrird la ventana
Export, la cual se muestra en la Figura 7.7.

e Escribir el nombre del archivo junto con la extension .msh en el cuadro de
texto Save As de la ventana Export. En esta ventana se selecciona también
la carpeta que contendra éste archivo.

e Seleccionar el formato de exportacién del archivo .msh como Mesh-Gmsh
MSH (*.msh). Luego hacer click en el botén Save.

e Seleccionar Version 2 ASCII en la caja Format de la ventana MSH Op-
tions y dejar sin marcar las opciones Save all elements y Save parametric
coordinates, como se muestra en la Figura 7.8.
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e Hacer clic en el boton OK

La conformacion de este archivo se puede consultar en detalle en la referencia
(Linero et al., 2020).

A Export =
()~ [0 « pericaz » pericazn » PEFTRI » DATOS = [ 42 ][ Buscar DATOS o)
Organizar v MNueva carpeta = @
¢ Favoritos pomiie D
2] PRBULmsh Archivo MsH
) 7] pulloutl.msh .. Archivo MSH MSH Options
e Bibliotecas 2] pullout2.msh .. Archivo MSH
2] pullout3.msh Archive MSH version 2 ASCII ¥ Format
& Grupo en el hogar =] pulloutd.msh .. Archivo MSH Save all elements
=) TRIDL.msh . Archive MSH
1% Equipo = - R Save parametric coordinates
L =] TRIO2.msh ) 1906:41 3., Archivo MSH
- 7] TRIO3.msh 2 190 Archive MSH
weied =] VigaOL.msh 1 Archivo MSH | =
7] Viga02.msh t ArchivoMSH
« i v oK Z Cancel
Nombre; man07.msh .
Tipo: [Mesh - Gmsh MsH (*.msh) - s .
’ | Figura 7.8: Ventana MSH Options.

Figura 7.7: Seleccién del nombre del archivo en la
ventana Export.

7.2. Ejecucion del programa en GNU-OCTAVE o MATLAB

Las funciones de célculo estan escritas en el lenguaje interpretado de GNU-OCTAVE,
siendo compatibles con MATLAB. Esto significa que es necesario alguno de los dos
programas para ejecutar éstas funciones.

Ya sea en GNU OCTAVE o en MATLAB, se requiere establecer el directorio
de trabajo del programa. Este directorio es la carpeta \PEFTRI, la cual contiene el
archivo PEFICA.m.

En GNU OCTAVE el directorio de trabajo se selecciona escogiendo la carpeta
en el Explorador de archivos. En MATLAB el directorio de trabajo se puede
seleccionar de la misma manera. Luego de establecer el directorio de trabajo y una
vez construido el archivo de entrada, éste se puede analizar a través de la runtina
PEFICA.m como una funcién de GNU-OCTAVE o MATLAB. La instruccion de

llamada al programa se ingresa en la ventana de comandos, y es la siguiente:

> PEFICA (adat) (ople)

donde (adat) es el nombre del archivo de datos, escrito sin extensién. Este archivo
debe estar contenido en la carpeta \DATOS.
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El pardmetro (ople) es la opcién de lectura de datos y escritura de resultados. A
continuacion se muestran los valores que puede tomar:

e (ople) = 10: es el valor por defecto. Se leen los datos de un archivo con extension
.msh de GMSH y se escriben los resultados de los esfuerzos y deformaciones
promedio en los nudos en los archivos .pos y.pos.opt de GMSH

e (ople) = 12: Se leen los datos de un archivo con extensién .msh de GMSH y se
escriben los resultados de los esfuerzos y deformaciones promedio en los nudos
en los archivos .pos y.pos.opt de GMSH. Se utiliza cuando hay mas de un
tipo de elemento finito o mas de un material.

Luego de ejecutar la instruccién anterior, el programa muestra las etapas de
calculo y su tiempo empleado, en la misma ventana de comandos.

En la subcarpeta \DATOS se encuentran los archivos utilizados en los ejemplos
mostrados en este trabajo.

7.3. Lectura de resultados en el programa GMSH

El médulo de post proceso del programa GMSH puede presentar de forma grafica la
configuracion deformada del sélido y las reacciones en los apoyos. Asimismo, puede
mostrar los resultados de desplazamiento, deformacién o esfuerzo.

En esta seccion se describira de forma breve los principales aspectos de la visua-
lizacién de los resultados utilizando el médulo de post proceso del programa GMSH.
En la referencia (Linero et al., 2020) se puede consultar con mas detalle el uso de
este programa para el postproceso.

El programa GMSH lee el archivo con extension .pos, el cual estd dividido en
bloques que contienen la malla de elementos y los resultados de desplazamientos,
reacciones, esfuerzos y deformaciones. También lee el archivo con extensién . pos.opt
el cual contiene las opciones de visualizacién de resultados (Linero et al., 2020).

El archivo que se abre desde el programa GMSH para visualizar el postproceso
es de extension .pos, el cual contiene la solucion al problema. Al abrirlo, en la
parte izquierda de la ventana principal de GMSH aparecen las diferentes opciones
principales de visualizacién de los resultados contenidos en el archivo de extension
.pos.

Cada una de las opciones presentadas en la parte izquierda de la pantalla se
puede activar o desactivar dando clic sobre ella. Esta accion activa o desactiva la
visualizacién de cada resultado sobre la malla de elementos mostrada en la ventana
principal.
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Estas opciones varian segiin el numero de categorias del problema. Cada grupo de
vistas de una categoria contiene: las componentes de esfuerzo o,,, oyy, 0.2, Ogy, 02 ¥
0y, los esfuerzo principales o1, 03 y 03, el esfuerzo de Von Mises 0,,, las componentes
de deformacion e,,, €4y, €22, Tay, Taz ¥ Tyz» ¥ las deformaciones principales €1, €2 y €.
Estas opciones se muestran en la Figura 7.9

A Gmsh - FAQOOPuliOut_HexaV2.pos = | = %

File Tools Window Help

[ Modules =
Geometry
Mesh
Solver
[=] Post-processing
v [0] Desplazamientos nodales
[1] Fuerzas nodales

[2] Esfuerzo prom. categ. 1 SXX
[3] Esfuerzo prom. categ. 1 SYY
[4] Esfuerzo prom. categ. 1 SZZ
[6] Esfuerzo prom. categ. 1 SXY
[6] Esfuerzo prom. categ. 1 SXZ
[7] Esfuerzo prom. categ. 1 SYZ
[8] Esfuerzo prom. categ. 1 SP1
[9] Esfuerzo prom. categ. 1 SP2

[10] Esfuerzo prom. categ. 1 SP3
[11] Esfuerzo prom. categ. 1 SVM
[12] Deformacion prom. categ.
[13] Deformacion prom. categ.
[14] Deformacion prom. categ.
[15] Deformacion prom. categ.
[16] Deformacion prom. categ.
[17] Deformacion prom. categ.
[18] Deformacion prom. categ.

1
1
1
1
1
1
1
1

g
LA S B R R R R SR EE SRR RS SIS ESESESE SIS

[19] Deformacion prom. categ. 1 EP2 0
[20] Deformacion prom. categ. 1 EP3
[21] Esfuerzo prom. categ. 2 SXX
[22] Esfuerzo prom. categ. 2 SYY
[23] Esfuerzo prom. categ. 2 5727 f
[24] Esfuerzo prom. categ. 2 SXY Desplazamientos nodales Y
[25] Esfuerzo prom. categ. 2 SXZ = 2.52e-008 2 18e-006 4 33e-006 Lr)(
2 . ~ I
SEOXYZ& 115 ] Done reading 'F\000PullOut_HexaV2 pos.opt'

Figura 7.9: Entorno grafico de GMSH para el post proceso.

7.3.1. Desplazamientos, condicién deformada y fuerzas en los nudos

Luego de abrir el archivo de extension . pos, el mdédulo de post proceso del programa
GMSH muestra la norma del vector de desplazamiento, designada como la vista
numero 0. Adicionalmente, se muestra la malla de elementos finitos sin deformar.
Si se desea cambiar el factor de amplificaciéon del vector de desplazamiento, para
ver la deformada con una escala aumentada, se selecciona en el ment desplegable de
la vista, la opcion Options. Esto despliega la ventana de opciones. A continuacién
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se da clic en la pestana Aspect. El factor de amplificaciéon de la vista se puede
modificar ingresando un nuevo valor en el cuadro Displacement factor.

Las fuerzas totales que actian en los nudos de la malla se muestran en la vista
numero 1. Por defecto se muestran los vectores de fuerza entrando a los nudos me-
diante flechas. El tipo y el tamano de las flechas se pueden modificar seleccionando
la opcion Options del menu desplegable de la vista Fuerzas nodales. Esta accién
abre la ventana de opciones, donde se da clic en la pestana Aspect. El tamano de
las flechas se puede modificar ingresando un nuevo valor minimo y maximo en los
cuadros de la opcién Arrow Size.

7.3.2. Componentes de esfuerzo y deformacién

Dependiendo de los tipos de elementos finitos utilizados y de la cantidad de mate-
riales asignados al sélido, se asigné un nimero de categorias. Para cada una de estas
categorias, el programa GMSH despliega una opcion de visualizacién donde se mues-
tran las componentes de esfuerzo oy, 04y, 022, Opy, Oz ¥ 0y, los esfuerzo principales
01, 02 y 03, el esfuerzo de Von Mises 0, las componentes de deformacion €,,, €y,
€22y Ty, Twz ¥ Ty, ¥ las deformaciones principales €1, €2 y €.

Los resultados para una sola categoria son evaluados como el promedio en los
nudos al ejecutar PEFICA con la opcién (ople) = 10. Para obtener los resultados en
los nudos para multiples categorias, se ejecuta PEFICA con la opcién (ople) = 12.

Cuando se presentan multiples categorias, los resultados de cada una se pueden
mostrar de forma simultdnea. Al visualizar de forma simultanea el mismo resultado
de dos categorias diferentes, el programa muestra una escala cromatica independien-
te para cada una. La explicacién detallada de las opciones que presenta el programa
GMSH para la visualizacién de resultados en el postproceso de los resultados genera-
dos por el programa desarrollado, se puede encontrar en la referencia (Linero et al.,

2020).
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